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Getting Started 

Thank you, for choosing Kothari Print Pro for your digital garment printing 
needs. This section will help you in installing the software on your computer 
machine and help you getting it running right away. 
 

Installation 

Enter the accompanying CD disk in the CD-ROM drive of your computer and 
the installation program should start running automatically. If it does not, 
run \Print Pro\Setup.exe yourself from the CD. 
 

Step 1: Follow the instructions given by the installation program to get the 
program installed on your hard disk. 
 

Step 2: Go to the root directory of the CD in the Windows explorer. Run the 
file InstallHasp.exe. This file is the installation program for installing the 
drivers for the accompanied lock on your PC‟s hard disk. Follow the 
instructions given by the installation program. 
 
Step 3: Connect the lock to the parallel/USB port of your PC depending 
upon the type of lock. If the lock is attached to the parallel port, you may 
attach printer cable to the other end of the lock. 
 
Step 4: Reboot your PC. 

 

Launching the Software 

You can run Print Pro either by double clicking its icon on the desktop or by 
selecting Start > Programs > Print Pro DTG Viper > Print Pro. 
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System Recommendations 

 Processor: Requires a PC based on Quad Core (2.2 GHz) technology or 

higher processor. 

 Operating System: Microsoft® Windows® XP or later. 

 RAM: 2GB DDR2 or more. 

 Hard Disk: Hard Drive with SATA interface and 100 GB free disk space. 

 Monitor: SVGA or better with resolution of 800 x 600 or better. 16 Bits 

or more color support recommended. 

 Printer: Subjected to specification. 

 

Limitations 

There is practically no limitation on output size when using Print Pro‟s 
custom printer driver. 
 
Rest of the portion of the manual will help you in getting familiar with the 
software and putting it to use. 
 
This manual assumes that you are familiar with Microsoft® Windows® 
Operating system and know the terminology and general Windows UI well. 
 
Most of the examples drawn here in this manual are from Textile printing, 
but are equally applicable to other forms of printing. 
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Organization of the Manual 

Next topic „About Print Pro‟ offers an insight into what this software can do 
for you. 
 
Rest of the manual is organized into three sections. 
 
Section I ‘On The Fast Track’ describes how to get quick production from 
the machine, the pre-press and the color management topics and Print Pro‟s 
support for it. These topics are as follows. 
 
1. Preparing Images for printing - Underbase Creation. 

2. Color management. 

 
Section II deals with the interface part of the software. It includes the 
following topics. 
 
1. Printing. 

a. Queue Manager 

b. Port Manager 

c. Printer drivers 

d. Print options 

 

2. Page Layout (Optional feature in the basic version of the software). 

3. Filters. 

4. The Application Interface. 

5. Productivity features. 

6. Common Error messages and Warnings. 

 

Section III deals with the ‘Platen Organizer' application (Optional feature 
in the basic version of the software), which is used to create and modify the 
layout templates. 
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About KITL 

KITL is a young and ambitious company with current focus on tools and 
technologies for color reproduction. 
 
Currently we at KITL have two major lines of products targeted for graphic 
arts and textiles.  
 
1. RIPS (Raster Image Processing software) and color management 

software for: 

 Screen making. 

 Large/ Wide format digital printing. 

 Digital Textile Printing. 

 Digital photo Mini Labs. 

 Proofing solutions for graphic arts. 

 

2. Color formulation and QC software for textiles. 

3. Inks and chemistry solutions for digital textile printing. 

 

To know more about our products and us please logon to our website 
www.kothariinfotech.com. 
 

http://www.kothariinfotech.com/
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About Print Pro 

This version of Print Pro has been designed for direct inkjet printing on 
garments. With the printing techniques used in direct garment printing 
getting increasingly sophisticated, the software catering to these techniques 
needs to keep in pace with them as well. Print Pro does that and takes it to 
the next level.   
 
With this special edition of Print Pro, you have, 
 
1. ICC based color workflow. 

2. Reads and uses embedded profiles if any, inside the image file. 

3. Interpolation support for high quality output. 

4. Custom printer driver for various Printer models (these drivers may vary 

based on the version of this software).  

5. Simultaneous RIP and Print. 

6. Rip once output many (ROOM). 

7. Save Ripped job for future use. 

8. Print selected layers from a ripped data, e.g., White underbase layer or 

color layer. 

9. Port manager to manage ports. 

10. Queue manager to manage jobs. 

11. Lots of other features to boost your productivity. 

12. Ability to connect to any windows compatible printer. 

13. Powerful page layout feature (Optional feature in the basic version of 

the software) to print job(s) on a single page with transparency support 

using predefined designs. 

 

Rest of the topics will explain you in detail the various options that are 

offered by Print Pro. 





7 

 
 
 
 
 
  
 

Section 1 

O N  T H E  F A S T  T R A C K  

 





 

9 

Getting Productive 

This is a quick reference guide that will walk you through some of the most 
basic features of Print Pro, which will help you start printing images on your 
machine right away using Print Pro. 
 
Before we begin, it‟s important for you to know that this edition of Print Pro 
has been designed to work the best with Adobe Photoshop. Later topics in 
this chapter will explain this in detail. 
 
Before you start, install the Windows USB port driver for printer as you will 

be utilizing this USB port for printing from Print Pro. 
 

Configuring Print Pro 

Please follow the below mentioned steps carefully. 
 
1. Launch Print Pro either using the desktop shortcut or from Start > 

Programs > Print Pro DTG Viper > Print Pro.  

2. Invoke the menu command Options > General Preferences… You will be 

presented with a dialog box as shown below. Choose the appropriate 

settings for the options labeled as „a‟ and „b‟.  

a. The value to be entered here depends upon how you are going to 

use your system. This value may range from 70% to 30%. For 

example if you are going to run Adobe Photoshop along with Print 

Pro at the same time then you may have to share the primary RAM 

between the 2 applications. Choose 30% for Print Pro and similar 

amount for Photoshop in the Photoshop. However if you are going 

to run Print Pro exclusively on the machine then you may choose to 

give Print Pro 60% or 70% of RAM. (However never allocate more 

than 600 MB to Print Pro). 

b. Select your primary and secondary hard drives from here. Print Pro 

uses hard drives to handle the images and uses RAM as cache. 

c. Click this button to remove secondary disks from the 'Used' 

column. 

d. Click this button to add available secondary disks to the 'Used' 

column. 
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e. Check this button to use cache for histogram. 

General Preferences 

 
3. Invoke the menu command Queue Manager > Port Manager. You will 

be presented with the following dialog box. Choose the appropriate 

settings for the options labeled as „a‟ and „b‟. 
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Port Manager 

 
a. Press the ‘Configure’ button to configure the port. You will see the 

following dialog on your screen. Enter 3600 seconds as the timeout 

setting and press OK. 

b. Choose the appropriate USB Port from the list. 

Port Configuration 

 

4. Invoke the menu command Color > Color Management… or use the 

keyboard shortcut <Ctrl> + <Shift> + <K> to get the following dialog. 

Choose the appropriate color spaces. Say if you are using Adobe 

Photoshop then you may want to keep the default color spaces same as 

in Photoshop. Also set the labeled items to following values if they 

already aren‟t. 
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Color Management Options 

 

 Default RGB : Select sRGB IEC61966-2.1 

 Default CMYK : Select U.S. Web Coated (SWOP) v2 

 

a. PCS Illumination: Select D50. 

b. Check ‘Accurate out of gamut simulation’. 

 

5. Close Print Pro and then re-launch Print Pro now for allowing the 

changes to have an effect. 
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Printing Images 

Printing images in general is a 3 step process. 
 
1. Open the image you want to print. Print Pro supports variety of raster 

file formats. However, working with Photoshop‟s PSD file format is 

highly recommended as among other things you can have transparency 

information embedded in it. Also refer „Preparing Images for Printing‟ on 

page 17. 

2. Tune the size and placement related information, if required. You can 

do that using the QRip. Access QRip by View > Show QRip command. 

See the figure below. See „Q Rip‟ for more details on page 157. 

Quick Rip Options 
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Printer Settings Tool Bar with Environment Selection 

 
3. Select the appropriate print environment from the printer settings tool 

bar (shown in the above figure) and give the print command (<Ctrl> + 

<P>). 
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Print Box 

 

a. Printer Name: This field specifies the name of the printer that you 

select to print the page.  

b. What do you want to print:  Select any one option to print either 

the whole page or selected portion. 

c. To Print: Enter the number of pages you want to print and the total 

number of copies that you want. 

 

If you are printing for the first time using the printer settings to the printer, 
and there is no port associated with it then you may be asked to associate a 
port with the current printer setting that identifies the printer you would like 
to print on. See the following figure. 
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Queue Manager when no Port is selected 

 

a. This field specifies the port on which data will be sent. Currently No 

port is selected. 

 

The following dialog shows the list of the available ports from which 

you can select one for your printing needs. 

Queue Manager with the Port Selection List 

 
Also refer to „Preparing White Underbase‟ on page 18. 
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Preparing Images for Printing 

If you are using Adobe Photoshop then it is recommended that you work with 
PSD file format. In that case preparing the image for printing on various 
color background becomes very simple. All you need to do is to knock the 
background off and make the area transparent. You can thus have a single 
target for all color backgrounds. 
 
Another advantage of working with this format is that you can have soft 
edges on the image boundaries that will allow smooth merging of the image 
with the background. 
 
In case of other file formats then you may have to generate image having 
the background color same as that of your printing substrate. For example to 
print on White substrate the background of the image should be white. 
Similarly to print on black substrate the background of the image should be 
black and so on. 

 
 Some sample images with background knocked off are shown below. 

 

Background Knock Off Sample 

 

As can be seen from the figure, the background has been knocked off to 
make it transparent making the image usable with printing base of any color. 
The grid in the right hand portion of the images represents transparency. 
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Preparing White Underbase 

You don‟t really have to do anything to create the white underbase, as the 
software automatically generates this for you. All you need to do is to choose 
the right printer setting. 
 
However you may feel some time the need for having White highlights. A 
white highlight is generally the area in the image which is either white or is 
close to white. Again this can be generated in the Adobe Photoshop and 
saved with the image as a Spot / Alpha channel. When the image is imported 
into Print Pro, the highlight channel is also read in. All you need to do before 
printing the image is to tell the software which channel contains the highlight 
information. To know more about how to do this, see Channel Palette on 
page 143. 
 
Highlight white is printed along with the color pass. 
 
Please note by default the highlight white is not printed along with the color 
data when printing on the white substrate, however you can turn on the 
printing of highlight white if you desire so. 
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Color Management 

So far throughout the manual, we taught you how to get productive with the 

software right away. In the remaining part of the manual we now explain the 
powerful control that Print Pro offers over the various variables involved in 
garment printing.  
 
Printing is all about producing color on the desired substrate. The details of 
the color are derived from the image data. This image data reflects the 
imagination of its creator. Under most circumstances we would like to have a 
conforming print to the image data or in other words WYSIWYG.  
 
Print Pro offers considerable support to this in the form of color 
management. The heart of the Print Pro‟s color support is its color 
management module. 
 
Print Pro‟s Color Management Module (CMM) is based on ICC (International 
Color Consortium) model. See the figure below. 

 

ICC Based Color Workflow 

 
Where Device 1 can be a RGB monitor and Device 2 can be a CMYK printer, 
and so on. Images rendered on Device 1 are rendered on Device 2 via PCS. 
This transformation helps in maintaining the same color appearance of the 
image on two devices. This is step towards WYSIWYG (What you see is what 
you get)*. 
 
 
 
 

PCS 

(Profile Connection Space) 

Device 1 Device 2 Device 3 … 

Device N 
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* Color management‟s effectiveness is greatly influenced by the proper 
characterization of the rendering devices and the differences in their color 
gamuts. 
 

What is Color Management? 

Color management allows you to create designs or images on one device and 
renders the same on other device having different colorimetry/ technology 
while maintaining the same color appearance. E.g., Color management will 
allow image viewed on the RGB monitor to appear same when printed on the 
CMYK printer. 
 

Print Pro Offers 

Print Pro offers color-managed workflow. This essentially means that Print 
Pro will use the device profiles to manage the color appearance across 
different color input/ output devices. 

  
Print Pro reads and uses any embedded ICC color profile present in the input 
image file.  
 
In absence of any embedded profile Print Pro uses one of the appropriate 
default ICC profiles as specified by the user. Use the Color management Box 
as shown in the figure below to specify the default color settings. 
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Color Management Box 

 

a. Monitor Profile: Select a profile from the drop down list. You can 

also choose the load option to load a specific ICC monitor profile.  

b. Default RGB: Select a profile from the drop down list, or choose 

the custom option from the list to define a RGB Setup. See also: 

Specifying RGB setup to page 26. You can also choose the load 

option to load a specific ICC RGB color profile.  

c. Default CMYK: Select a profile from the drop down list, or choose 

the load option to load a specific ICC CMYK color profile.  

d. Source of illumination:  Illumination source for Profile Connection 

Space.  

e. Matrix based RGB profiles: Check 'Accurate out of gamut 

simulation'. 
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Specifying Spot Color Gain 

For spot channels/screens you can specify the spot gain by using the „Gain 
Setup Box‟ as shown in the following figure. 

Gain Setup Box 

 

a. Gain type selection: If standard gain type option is selected, then 

use the Value box labeled (b) to enter the gain value at 50% gray 

level. If the option selected is curve based then use the „Gain Curve 

Box‟ as shown in below figure to specify the desired gain curve.  

b. Amount: „Value Box‟ for gain at 50% gray level. Valid gain range is 

between (-10% to 50%). 
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Gain Curve Box 

 
The above figure specifies the options of the Gain curve box. 
 
Print Pro uses CIE LAB as PCS (Profile Connection Space) and uses Relative 
Colorimetry. See the figure below to know how Print Pro color manages the 
images. 
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Print Pro Color Workflow 

 

RGB Image / Indexed Images 

 
RGB Space           PCS           Monitor / Printer Space (for printing) 

If no RGB profile is present then default RGB profile is assumed. 

 
Grayscale Images 

 
Gray Space           PCS           Monitor / Printer Space (for printing) 

If no embedded Gray profile is present then default RGB profile is assumed. 

 
CMYK Images 

 
CMYK Space          PCS          Monitor / Printer Space (for printing) 

If no embedded CMYK profile is present then default CMYK profile is assumed. 

 
Spot-Channel Gain Model 

 
Used for modeling the gain profile of the spot channels during channel 

composition. CMYK channels are not subjected to spot gain. 

 

Note: All output before transferring to printer is converted to SRGB as almost all 

windows compatible printer driver assumes the printers to be RGB printers. 

 
Print Pro doesn’t use Windows ICM in its processing pipeline. 
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Transfer Curve Editing 

Transfer Curve Adjustment Box 

 

a. Gray Ramp: Indicates ink levels from 0% to 100%.  

b. Channel Box: Box listing all the channels/screens in the design 

showing the channel/screen for which settings currently are being 

established.  

c. Same curve for all channels: Checking this option results in Print 

Pro using the same TRC for all the screens.  

d. Load Button: Press this button to load a previously saved TRC 

from the disk.  

e. Save Button: Press this button to save the current TRC on the 

disk.  

f. Save all channels Button: Press this button to save the TRC of all 

the channels on the disk. 

 

Editing the transfer curve interactively is a very easy task. 
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There is a handle to every key gray level specified by the boxes on the right. 
As you move the mouse and click the left button, depending upon the mouse 
position, one of these handles gets visible (depending which is the nearest) 
and gets close to the clicked point. You can then drag the point to give the 
curve the shape you desire. You can delete/ hide a handle by dragging it 
outside the grid area, except the first and the last handle. Key values are 
updated automatically in the respective boxes as the curve is being edited. 
 
Any values entered through the boxes are also reflected on the drawn curve 
automatically. 
 
Pressing „Save‟ button, you can save Transfer Curves as Print Pro‟s TRC 
format file on the disk for later recall. 
 

Specifying RGB Setup 

RGB Setup Box 

 

a. Predefined RGB type.  

b. Custom RGB setup name.  

c. Predefined RGB phosphor.  

d. Custom RGB phosphor.  
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e. White point.  

f. Custom D illuminant temperature.  

g. Custom white point.  

h. Gamma for RGB.  

i. Load RGB ICC profile.   

j. Save current RGB setup as ICC profile. 

 

Color Management Options 

The following menu shows the features offered by Print Pro for the color 
management tasks. 

 

Color Menu 

 

a. Color Management: For more details see „Color Management Box‟ 

on page 20.  

b. Spot color gain: For more details see „Specifying Spot Color Gain‟ 

on page 22. 
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Printing 

Tools for Managing Printing Workflow 

Tools for managing printing workflow – 
 

1. Print queue manager. 

2. Port manager. 

3. Printer driver. 

 

Print settings are accessible through Print Settings Dialog Box. 
 
Let‟s understand these features one by one. 
 

Print Queue Manager 

The Print Queue Manager manages print jobs. It manages a queue of jobs 
and jobs get serviced in order they come.  
 
The queue manager is responsible for simultaneous RIP and Print, RIP once 
Print many, Job order changing, deleting, holding as per the priority. 
 

How to Use? 

You can access Print Queue Manager from Application Window by selecting 
the QueueManager > Show Queue Manager. 
 
The Queue Manager interface will appear as shown in the Figure below. In 
order to hide Queue Manager Interface you can either select Queue Manager 
> Hide Queue Manager or click the close button on the top-right corner of 
the interface. 
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Print Queue Manager Interface 

 
 Toolbar 
 Job queue 

 

Tool Bar 

Let‟s see the Toolbar option of Print Queue Manager. Figure below is just a 
part of the above figure. 

Print Queue Manager Tool Bar 

 

a. To load a Job in the queue. You can also do this by QueueManager 

> Load Job menu too.  

b. To add the active document i.e. currently working document. You 

can also do this by QueueManager > Add The Active Document 

menu too.  

c. To remove the selected job from the queue. 

d. To pause the selected job in the queue.  

e. To resume the selected job in the queue.  

f. To cancel the processing of the selected jobs in the queue.  

g. To print the selected jobs in the queue.  

h. To rip the selected jobs in the queue.  

i. To save the selected job in ‘kprn’ file format.  

j. To get the printer setting dialog box.  

k. To get the print options dialog box.  

l. Show Job Thumbnail in tool tip: Check this option to show the 

thumbnail of the ripped job. When you move the mouse on the 'Job 
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Info' field of ripped job at that time thumbnail of job will be visible. 

If you do not want to display the thumbnail then uncheck this 

option. This option is helpful when you load the saved job (KPRN 

file) from disk and you want to know the content of that saved job. 

See the figure below, 
 

Job Thumbnail in Tool Tip 

 

m. Eject platen from feeding side: Check this box to eject platen 

from feeding side. 

 

Note  

KPRN files are Kothari printer files used to save the printer data 

where as PRN files are printer files written in the internal format 

needed by the printer. Printing a „kprn‟ file is very fast. 

 

Tip  

You can also right click and drag to the printer queue, the 

document that you want to add to the printer queue. 

 
 

Job queue 

As in the figure „Print Queue Manager Interface‟, Job Queue contains seven 
fields for each job. These fields are explained below, in the same order as 
they appear in the figure from left to right. 
 
1) S No.  

This field specifies the position of a job in the queue. 
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2) Job Info  

This field contains job information in tree form as shown in the following 

figure. To expand the tree click on the plus sign. To collapse this information, 

click on the minus sign. 

Job Info Tree 

 
The job info tree contains the following information for the job. 
 

a. Name of Job: Root node of the Job Info tree specifies the 

name of the job.  

b. Job Dimension: Specify the width and height of the job in 

Inches.  

c. Number of Pages: This is the total number of pages in the 

job, irrespective of how many are requested to be printed. 
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d. Pages to Print: Specify the page numbers of the pages to be 

printed. Initially it shows the string 1-n (where n is the value of the 

Number of Pages field), which implies that all the pages will be 

printed. It is an editable field. You can edit this field if the status of 

the job is in either one of the Holding, Cancel or Error state. If you 

need to edit this field then enter the page numbers and/or page 

ranges separated by commas. For example if a job contains total 

number of 12 pages and you enter the string 1,3,8-12, then 

following pages will be printed 1,3,8,9,10,11,12.  

e. Input Color Mode: Specify the input color mode of the job.  

f. Output Color Mode: Specify the output color mode of the job.  

g. Printer: Specifies name of printer to which the print is targeted.  

h. Media Type: Specify the media type on which job was printed. 

i. Ink coverage: Total ink used to print the current job. Ink usage 

unit is shows as per the amount of ink used. It shows the ink 

amount used for all inks individually (Optional feature). 

j. Total Ink cost: Cost of the ink used. You can change the ink cost 

by using the Option > Ink cost… menu command. Refer page 161. 

(Optional feature). 

 

 

3) Status Field 

This field specifies the current status of the job, e.g., Holding, Ripping, 

Printing, Saving, Pause, Resume or Error (if some error occurs during the 

processing).  

 

Other states are transient states and their Interpretation is as follows: 

 

a. Printing Composite / Screen I (Page x of n (y %)): This 

message implies that your job contains total number of n pages and 

page number x is currently being printed and y percent of it is done. 

Composite implies that current printing page contains the composite 

color image.  

b. Waiting to print: This implies that job is waiting for its turn to 

print as Queue Manager is already servicing the maximum jobs 

possible. 

c. Waiting to rip: This implies that job is waiting for ripping because 

Queue Manager already servicing to the maximum jobs possible. 

d. Waiting to save: This implies that job is waiting for saving because 

Queue Manager already servicing to the maximum jobs possible.  
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e. Printing ( Color layer 1 of Page 1 (600.00 KB/650.00 KB)), 

Spooling Composite ( Color layer 1 of Page 1 of 2 (11%) ) : 

“Color layer 1 of Page 1 a (KB/MB) / b (KB/MB)” means „a‟ KB or MB 

of data is printed from total of „b‟ KB or MB of data of color layer 1 

of page 1. Spooling Composite (Color layer 1 of Page x of n ( y% ) ) 

means color layer 1 of page number „x‟ of the total pages „n‟ is 

spooled to „y‟ percent. 

 

4) Approximate Print Run Time 

This field shows the approximate print run time of the job. 

  

5) Copies Field 

This field specifies the number of copies of the job to be printed. You can edit 

this field when the job is in one of the following state - Holding, Cancel or 

Error.  

  

6) Port Field 

This field specifies the port on which data will be sent. Left clicking on this 

field a drop down list of ports appears from where you can select any one of 

the port listed for printing. 

 

Refer  Port Manager for more details on page 40. 

 

7) Save location 

This field specifies the path of the file where the printer data can be saved. 

Initially this field displays the default save location. You can change this 

default save location by clicking on save location field. You can now either 

enter the path of the saving location directly in the edit box or you can 

browse for the path by clicking on Save As button as shown in the Figure 

below. 
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Save Location 

 
On clicking the Save As button a common Save As dialog box appears. There 

you can give the path for storing the file. 

 

Tip  
Right clicking on the job in the job queue will give you access to 

options relevant to the current state of the job. 

 

Selective Printing  

Selective printing allows you to print only the selected layers from the print 
job. To use this feature it is necessary to use custom driver for the printer 
and then rip the print job. After ripping the job successfully you can go on to 
print selected layers. 
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Selective Printing 

 

After the job has been ripped, right click on the job and from the menu that 
is displayed select „Print Selection…‟ item. This dialog allows you to select the 
desired layers. 

 

Print Selection 

 
In the above dialog you can select the layers and pages to print by checking 
the corresponding box. 
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Print Queue Manager Preferences 

There are more options Print Queue Manager offers as preferences to make 
printing more yielding. These are available as Print Queue Manager‟s 
Preferences. You can access „Print Queue Manager Preferences‟ by selecting 
the menu command Options > Queue Manager Preferences. The „Preferences 
Box‟ is as shown in below figure. 

 

Print Queue Manager Preferences 

 
a. After Print: There are two options either holds the job or remove 

the job from the queue after a job is printed. This field allows you to 

select one of the options either Hold Job or Remove Job. By default 

Print Queue Manager hold the job after print.  

b. Enable Simultaneous Rip and Print: There are two ways to print 

a job either simultaneous rip and print or print the job after ripping 

the whole job. This check box allows you to enable the simultaneous 



 

40 

rip and print option. By default Print Queue Manager provides 

simultaneous rip and print.  

c. Show only online/connected ports in the list: When this option 

is checked, „Port Manager‟ shows USB port only on which currently 

printer is connected. If this option is unchecked then „Port Manager‟ 

shows all the available USB printer port into the system.  

d. Use Windows Temporary File Path: Print Queue Manager creates 

a temporary file for its own use when a job is added in the queue. 

When you remove the job from the queue QueueManager removes 

this temporary file. By default Queue Manager chooses the Windows 

temporary file path for these files but you can change this file path 

also by using the browse button. Select this check box if you want 

Windows temporary file path for the creation of these temporary 

files.  

e. Printing thread count: This edit box is used to specify the drive 

number of printers that can be addressed simultaneously. Maximum 

it can be 100 (Optional feature). 

 

Port Manager 

This tool provides the Print Queue Manager with the support of talking to the 
printing devices. As we have seen in the previous topic in „Print Queue 

Manager‟ the sixth field is for port and the Port manager manages it. 
 
You can access the Port Manager form QueueManager > Port Manager. 
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Port Manager 

 

a. Add: To add the new port.  

b. Remove: To remove the existing selected port.  

c. Configure: To configure the selected port.  

d. Refresh: To refresh the port tree.  

e. Finish: To close the Port Manager box. 

 

Configuring the Port 

You can configure the ports as per your requirement by pressing the 
configure button (labeled „c‟ in Figure above) for all those ports for which this 
button is enabled.  
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For USB ports you will get the following configuration dialog: 
 

Port Configuration 

 
Timeout Setting: This parameter lets the software know the time interval 

between two consecutive attempts to connect to the printer. 
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Printer Driver 

This edition of Print Pro offers customized printer drivers for your printing 
needs. Now onwards we will use the term Custom Driver in place of Print 
Pro Driver. 
 
Now, we will look into the details. 
 

What is Custom Printer? 

Custom printer is a collection of printer drivers for which Print Pro does not 
depend on the printer manufacturer driver but has its own driver, which 
drives the printer. Custom printer drivers have been specifically designed for 
the application specific requirements. 
  
Printer setup option for custom driver: 
 
You can access the „Custom Print‟ box by File > Print Setup or 
<Ctrl>+<Shift>+<P>.  
 
The dialog box is shown in the following page: 

 
This dialog box has two pages accessible through the tabs named „Print 
Environment‟ and „Summary‟.  
 
Before we move further, a word on a concept called print 
environment. Print environment are the files that saves the snapshots of 
the settings on a Print setup box. They can be saved on the disk as „.Env‟ 
files.  
 
Print environment contains all the information that is needed to print with a 
certain media. It contains among other the printer driver used, Media 
properties, selected port, position from where to print etc. All data are 
selected automatically when you select the appropriate print environment. 
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Print Environment Page 

 
Print Environment Page 
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a. Environment name: It shows the currently loaded environment 

settings. As described earlier you can save the snap shot of a print 

setup as print environment file. Default settings of a printer are 

always loaded as “Custom”. You can select the environment from 

the drop-down list. It shows the environment entries in the 

tree with group name shown as below, 

 
b. Manage env: This button enables a user to load to associate a 

generic name with an environment file. The user can then select the 

name associated from the name list to load the environment 

settings saved in the environment file associated with the selected 

name. Pressing the button displays “Manage Environment” dialog 

box. For details see “Manage Environment” on page 47. 

c. Manage env Group: On clicking this button enables a user to 

manage the environment file into group. Pressing the button 

displays the "Manage Environment Group" dialog box. Refer page 

50. 

d. Load env: This button enables a user to load to a previously saved 

environment file. A print environment can only be loaded if the 

printer specified in the environment is currently present in the 

printer list.  

e. Save env: 'Save env' button enables a user to save all the printing 

settings into a file so that he can use this file to print another image 

with same settings in future.    

f. Printer name: It shows the currently selected driver. User can 

select another driver from the dropdown list.  
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g. Properties: On clicking this button lets you to set up the properties 

for printing accessible through 4 different options as follows- 

1. Media. 

2. Printing Ink Assignment. 

3. Color Correction. 

4. Device Options. 

 

h. Media size: This field shows the list of media (paper) supported by 

the printer. Here we can specify the page size we want to use. If the 

printer supports custom paper sizes then select one of the “User 

defined” paper sizes from the list whose size can be defined by the 

user by clicking the „User size‟ button.  

i. Source: This part basically determines from where the media is 

inserted for printing.  

j. Selected port:  It contains information about the port to which 

your printer is connected.  

k. Ink layer order: This field specifies the ink layer transfer order, 

means whether you want to print first white layer and then color 

layer or color layer and then white layer.  

l. Platen placement on printing bed: Specify how you want to 

place your platen on the printing bed. You can also specify the 'Left' 

and 'Top' position of the platen by selecting the "Custom" option 

from the dropdown list.    

m. 'Left' and 'Top' position specification of platen when 'Custom' 

option is selected.  

n. Size change caused by addition processing.  

o. Unit: This button allows the user to change the measurement unit 

of various options (like Page size, Margin, Offset…). User can also 

change the unit by clicking the right mouse button on this page and 

selecting the desired unit from the menu. The currently supported 

units are Inch, Centimeter, Millimeter and Points.  

p. Feed adjust between layers (in mm): Specify the feed 

adjustment between layers in 'mm'.   

q. Platen ejection direction: Check this box to eject platen from the 

feeding side. 
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Manage Environment  

 

What is an Environment? 

Print Pro offers you the feature of saving the printer related settings in a file 
called an environment file. Print environment contains all the information 
that is needed to print with a certain media. It contains among others the 
printer settings used, printer profile and TRC curves used, information about 
the ink slot order and the inkset used, margins, etc. All data are selected 
automatically when you select the appropriate print environment. 
 
You can save environment files of different configurations and load them 
whenever you need them. You can save environment names for env files 
which makes selecting a set of printing settings just a matter of selecting the 
environment name. This saves a lot of time spent in selecting the different 
options as per requirement every time the media or some other parameter is 
changed.  
 
This dialog allows you to associate generic environment name with an 
environment file. To load the environment you need to select the 
environment name from the list. 
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Manage Environment Dialog 

 

a. Environment Name: This denotes the name associated with the 

environment file in the second column. It can be edited by first 

selecting the desired name and then clicking on the selected name. 

b. Environment File Path: This is the path of the environment file 

with which you wish to associate the environment name. This field 

can be modified in the same way as the environment name can be. 

c. Environment Group: This is the name of the group to which 

particular environment belongs. You can change the environment 

group by click on the group name. It shows the all the available 

group in the drop-down list as shown in the figure below, 
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Group in Manage Environment 

 

d. Environment File Path Browse button.  

e. Environment File Path Edit box.  

f. Reset environment list to factory default: Click this button to 

reload the environment list to software default.  

g. Add Env: Allows you to add a new environment name.  

h. Delete Env: Allows you to delete selected entries from the list. 

 

Right clicking in the environment list will display the following menu which 
allows you to add or delete entries. 
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Manage Environment Group 

Manage Environment group is helpful to manage the environment files into 
the group, so you can easily identify the required environment file as per the 
environment group. 

 

Manage Environment Group Dialog Box 

 

a. Name of the group.  

b. Environment file name present into the group.  

c. Associated group list.  

d. Press this button to move the environment file into the selected 

group item into the associated group list. This buttons enabled only 

when appropriate environment is selected in 'Environment list' and 

appropriate group is selected in the 'Associated group' list.  

e. Add new group. You can use <Insert> key to add a new group.  

f. Remove the selected group. Environment file present into the 

group which is going to delete are moved into the 'None' group. By 

using <Del> key you can delete the selected group. 
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Right clicking in the environment group item or folder will display the 
following menu which allows you to add, delete and rename group item and 
transfer environment into new associated group. 

 

 

Note  
You can re-group the environment file by using the <Ctrl> + 

Dragging the item and dropping on to the new group. 

 

Note  You can not delete the item 'None' from the Environment list. 
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Summary Page 

Summary Page of Custom Print 

 
a. Summary: Summary of the settings made by the user.  

b. Remark: User Sets remarks. 

  

Summary page shows the summary of the options selected for printing the 
document. This page shows the current printer selected, paper size used to 
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print, print margins, print quality, media type used for printing, print 
resolution, currently loaded ICC profile, and user remarks if any specified by 
the user while creating the print environment. 
 
On pressing the button with the caption “Properties...” labeled as „g‟ in „Print 
Environment page‟ you will be presented with the print properties dialog.  
 
Print properties are grouped under 4 main categories accessible through 
individual tabs on the „Print Properties Box‟. These are as follows- 
 
1. Media. 

2. Printing Ink Assignment. 

3. Color Correction. 

4. Device Options. 
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Media Page 

Media Properties Page 

 
a. Media size: Media size shows the list of media (paper) supported 

by the printer. Here we can specify the page size we want to use. If 

the printer supports custom paper sizes then select one of the “User 
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defined” paper sizes from the list whose size can be defined by the 

user by clicking the „User size‟ button ( labeled „c‟ )  

b. Source: This is from where the media is to be inserted for printing.  

c. User size...: This button is enabled when the user selects “User 

defined” paper size from the media size list. When you click this 

button a dialog box appears asking for the width and height of the 

new media you want to create.  

d. Add/Remove paper...: This button is used to add the new paper 

size or you can remove the paper size which is newly added by you.  

e. Media type: It specifies the media on which user wants to print. 

This can be a user created media or a predefined media. Basically 

by selecting a new media user selects a new ICC profile and TRC 

curves for printing which was selected by the user while creating 

that media. Media type can be dependant on ink type or can be 

independent depending on the printer selected. If a media type is 

dependant on ink type then only those media are shown which the 

selected ink type supports. User can still override the ICC profile or 

the TRC curve used by selecting appropriate files using „Load TRC…‟ 

and „Load printer profile…‟ buttons.  

f. Ink: Ink type shows the list of ink type supported by the printer. 

Many printers have media type dependant on ink type i.e. for one 

media type you may want to select the different TRC curve and ICC 

profile and for other ink type a different set.  

g. Create media...: Create media button is used to create a new 

media or remove a media created.  

h. Check bar options...: Use this button for the alignment of bars.  

i. Load TRC: Use this option to change the TRC curves used for 

printing an image.  

j. Load White TRC: Use this option to change the TRC curves used 

for printing the white base for an image.  

k. Load printer profile: Use this option to select a different ICC 

profile for printing. Remember always load the same number of 

channel ICC profile as in the currently loaded inkset.  

l. ICC Profile: ICC Profile shows the currently loaded ICC profile 

name.  

m. Test Patches: This test is carried out to determine the order of 

inks in the printer, for printing other test patches.  

n. Left Margin.  

o. Right Margin.  

p. Bottom Margin.  

q. Top Margin.  
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r. Remark: Remarks are the user given comments for the given 

environment setting. The user for recalling why he made these 

settings for the environment can use this as a memory aid. 

 

User Size 

 

Working with Non-Standard Paper Sizes 

Specify a media of a non-standard size. Enter the width and the height of the 
page and press OK denoted by the "tick" marked button. You can change the 
unit of parameters by right clicking in the area of the dialog box and change 
the unit to any one of cm, inch, mm, point.  

 

User Size Box 
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Add Remove Paper Size 

In addition to that you can also save a specific user sized paper with any 
name you want by pressing the button with the caption “Add/Remove 
Paper..” labeled as „d‟ in „Media Properties Page‟ figure. You will see the 
following dialog. 

Add / Remove Paper Box 

 
a. Media Size: This field shows the name of the user defined paper 

size.  

b. Width and Height of the media.  

c. Add Paper: Add the user defined paper size in the list.  

d. Remove Paper: Remove the paper size from the list. 
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Create Media 

Media is a combination of a TRC, an ICC profile and an inkset (if applicable to 
that printer) that can be saved by the user and utilized later. On selecting a 
particular media, the corresponding TRC and ICC are both loaded.  
 
To create a new media or to alter the settings of an existing media click the 
button labeled as „g‟ in „Media Properties Page‟ figure and you will be 
presented with the following dialog. 

Create Media Box 

 

a. Media type: Name of the media that can be specified by the 

user or can be selected from the drop-down list. Ink type: 

Name of the media that can be specified by the user or can be 

selected from the drop-down list. 

b. Ink type: Name of the media that can be specified by the user 

or can be selected from the drop-down list. 

c. Load Profile: Specify the path of the suitable ICC profile for 

the specified media. 

d. Load TRC: Specify the path of the suitable TRC curve for the 

specified media. 

e. Load White TRC: Specify the path of the suitable TRC curve 

for the specified media for printing using white base. 
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f. Add media: Click on this to add the newly specified media. 

g. Remove media: Remove the current media. 

 

 

Check Bar Options 

 

Check Bar Options Box 

 
a. Align bars to: Select bars to align either to margin or Image.  

b. Enter the width of the bar and its distance from the image.  

c. Bar position: Select the position of the bar.  

d. Unit: Unit of measurement. 

 

Note 
A user can delete all media for a given inkset except the last i.e. at 

least one media should be present for a given ink type. 

Note 
You can right click anywhere within the dialog box to change the 

units of measurement. 
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Generate Ink Order Test Patches 

Test Patches Box 

 

a. Patch Type: You can select the following patch type - To determine 

ink order.  

b. Page dimension: The dimension of the page on which the patches 

are being printed.  

c. Patch Size: Size of the patch Width (X) and Height(Y).  
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d. Gap Dimension: Gap between neighboring patches horizontally(X) 

and vertically(Y).  

e. Page offset: Specify the offset with which the page will be printed.  

f. Black channel number: For CMYK the channel number is 4. This 

color will be used for labeling the patches being printed.  

g. Unit: You can select the units as per your requirement from this 

drop-down list. 

 

As can be seen in the above figure there are more options but these are 
irrelevant to Ink order test. After having entered the input parameters press 
'Print' button at the bottom of the dialog shown by the printer icon on the 
bottom right corner of the dialog. 
 

In the test print you will observe a patch for every ink present in the inkset 
of the printer and a number printed alongside each patch. These numbers 
represent ink slot number. Select color as printed corresponding to each slot 
number in the „Printing Ink Assignment‟ page of the Print properties dialog 
box. Now the software knows which printer channel contains what ink. 
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Ink Assignment Page 

Ink assignment page contains the information about the currently loaded 
inkset used for printing. This page will show only those inksets which are 
supported by the printer i.e. if the printer is a 4 channel printer then only 
those inksets will be shown for which the number of inks in the inkset is 
equal to or less than four. Once a proper inkset has been chosen then always 
remember to choose the corresponding ICC profile. Now assign each channel 
with the given slot in the printer. If you don‟t want to print using a channel 
then set that channel slot number as zero. Color channels marked for no use 
are ignored during printing but each specified color channel has to be 
rasterized. 

Ink Assignment Page 
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a. Predefined Ink sets: List of inkset supported by printer.  

b. Entries of the selected inkset.  

c. Restore to last settings: On clicking this option the last settings 

that were set by the user, as the default will be restored.  

d. Restore to factory default: On clicking this option the printer 

setting in the software will restore to the factory default settings.  

e. Set as default: when user clicks this button then the current 

setting will be set as the last used settings and these settings will 

be loaded automatically when the user selects this printer next time 

or clicks the button “Restore to last setting”. 

 

 

 

Note 
When the specified color order does not meet the actual color order 

in your printer "false" colors will be printed. 

Note 

This feature ("Ink Assignment Page") may not be available in some 

cases depending upon whether your printer supports modifying of 

printing ink assignment or not. 
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Color Correction Page 

Color Correction Page 

 

a. Printer Name: Displays the name of the selected printer. 

b. Edit Profile for primaries: Check this to edit manually change the 

blends of the selected profile. 
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c. Adjust Primaries: This button pop ups the dialog box which lets 

you adjust the blend manually.  

d. Printer color adjustment: Check this for color adjustment.  

e. Sliders: Use these sliders for color correction.  

f. Color booster: Adjust the percentage to increase the amount of 

color depth. 

 

Primary Adjustment 

Primary Adjustment Dialog Box 

 
a. Manually adjust the blend of the selected profile.  

b. On clicking this button will automatically estimate the amount of 

color used for any primaries.  

c. Load the primary adjustment.  

d. Save the changes made in the primary adjustment. 
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Device Options 

Device Options Page 

 
a. Underbase option: This underbase option will allow you to select 

whether the printing is for white underbase printing or for color data 

printing. This option is disabled when either the printing is on white 



 

67 

printing base (see 'b') or “Use same settings for white base or color” 

(see 'o') has been set.  

b. Printing base: It allows you to select the color of the printing base. 

It can be one of the following:  

1. White  

2. Black  

3. Color  

4. Dark Color (Optional feature in the basic version of the 

software)  

 

c. Resolution: Select the resolution at which you wish to print.  

d. Color appearance: Select the output color mode which is by 

default selected as 'Colored'.  

e. Microweaving: This option allows the printer to generate superior 

output because graphics data is reordered and is printed in finer 

increments. It reduces the possibility of banding, the light horizontal 

lines that can mar an image.  

f. Print Direction: This option allows you to set the printing direction. 

It can be unidirectional or bidirectional or automatic.  

g. Dot size: Using this option you can set the size of the dot for 

printing.  

h. Optimize Ripping: Checking this option will increase the ripping 

speed.  

i. Wet on wet passes: Number of passes to be printed on same 

position.  

j. Banding correction: Perform settings for media feed 

compensation. This corrects the errors in the amount of feed of the 

grit rollers due to the type of media used. Correcting the amount of 

feed improves the dot positioning accuracy in the feed direction, 

which can help in enhancing the image quality.  

k. Layers count: Enter the no. of layers of white underbase or color 

data to be printed depending on the option selected currently.  

l. Dry time per scan: Specify the time (in milliseconds) for which the 

head waits before printing each line.  

m. Dry time before reprint: This setting allows the control of the 

amount of time (in seconds) after which the next layer is to be 

printed.  

n. Strength: As the name suggests the strength option is to control 

the amount of application of each individual option. 0% means no 

strength and 100% means full strength. In past whatever you  may 

have created and used with the software was at full strength 100%. 
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Now you could control the application of the amount of the feature. 

For example, if you use the Choke Strength to be 50% then the 

choking will be applied by 50% amount of the gray value in the 

corresponding channel. Similarly, if you use the Underbase Strength 

to be 50%, the underbase that will be printed will be half the 

strength that otherwise would be printed when this value is 100%.  

o. Use Same Settings: Allows you to set the same settings for white 

underbase and color layer(s). The option will be enabled only if you 

are printing on black or colored printing base.  

p. Highlight Generator: There are four options-  

1. None: If you don't want to use "Highlight Generator" 

during printing then select this option.  

2. Channel Based:  Highlight option will work as usual using 

the channels. Fuzziness value is disabled and ignored.  

3. On the fly: The RIP will generate the white highlight on 

the fly during ripping using the fuzziness value that you 

supply there. This will ignore any highlight channel set 

otherwise in the channel palette. The fuzziness value works 

similar to the highlight channel creation option.  

4. Combine: The RIP will generate the white highlight on the 

fly during ripping using the fuzziness value that you supply 

there and will combine it with the highlight channels set in 

the channel palette. The fuzziness value works similar to 

the highlight channel creation option. 

 

q. Highlight Fuzziness: The fuzziness value works similar to the 

highlight channel creation options. This will be disabled in the case 

of Channel based Highlight generator.  

r. Allows you to set the settings back to factory default.  

s. Allows you to restore the last settings.  

t. Allows you to set the current settings as default settings. 
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Print Settings 

Print Pro offers comprehensive control over print settings. Print setting is 
accessible through File > Print Option from the Application Window or by 
using the shortcut <Ctrl> + <T>. 

Print Options Dialog Box 

 
a. As in document: The image in output print is exactly of the same 

size as the document‟s dimension.  

b. 1 to 1: Selecting this option results in Print Pro using the printer‟s 

resolution for the image, in place of the original image resolution. In 

other words each image pixel corresponds to a printer pixel. This 

option is not allowed in layout.  

c. Fit to page: Selecting this option results in Print Pro scaling the 

image to fit the page size. In case of Page Layout, set job sizes 

same as platen size. This option fit the job size into platen.  

d 
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d. Custom: Selecting this option allows you to adjust size or scale 

factor of the image or job.  

e. Maintain aspect ratio: Checking this option forces Print Pro to 

maintain the aspect ratio of the image.  

f. Resampling: The following resampling methods are available:  

1. Stretch and truncate: Fastest method for expansion or 

reduction of images.  

2. Bilinear: Little slower, but produces better images than 

stretch and truncate.  

3. Bicubic: Expensive, but produces best results of the three 

available methods. 

 

g. Image positioning: Use one of the predefined positions or supply 

the custom position to place the print‟s Top Left on the output. In 

case of Page Layout negative placement is allowed when 'Custom' 

option is selected in position.  

h. Mirror Image: Checking this option will mirror the image about the 

vertical axis in the print.  

i. Invert Image: Checking this option inverts the colors of the image 

in the print. 

 

Note 
Pixel unit is defined in the image space and appropriate 

scaling is done before printing to the printer.  

 

Note 

In case of 'Page Layout' you can set placement position within 

the allowed range such that job does not goes out side the 

platen rectangle. 
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Print Previewing 

This feature allows user to view what each page will carry when it is printed. 
User can change the settings and Preview the effect immediately. Please 
refer figure below for more details. 

 

Preview Window 

 
 
 
 
 
 
 
 
 
 
 

m 
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Print Preview Toolbar 

 

a. Print the document.  

b. Printer settings.  

c. Print options.  

d. Advance to the next page.  

e. Go back to previous page.  

f. Preview single page at a time.  

g. Preview two pages at a time.  

h. Zoom In.  

i. Zoom Out.  

j. Click here to change the Background color for print previewing. 

After selecting the color background the image will look as in the 

figure given below. The background color is applied all over in the 

transparency part of the image.  

k. Context sensitive help.  

l. Cancel preview. 
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Image after Applying Background Color 

 

Note 
Right click anywhere inside the window to access the list of 

commonly used commands as shown in the next figure. 

 

Right Click Commands in Print Preview Mode 
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Page Layout 

(Optional Feature) 
 

The Print Pro RIP offers you a very reliable and handy “Page Layout” feature 
which allows the use of predefined templates for job placements. Using this 
feature you can print on white, color and black media at the same time! 
 

What is 'Page Layout'? 

There can be times when the jobs to be printed are much smaller than the 
print bed of the printer. Thus multiple such jobs can be printed at the same 
time to boost the productivity. Usually the placement of such jobs is fixed on 

the print bed. Such placements can be specified in the form of predefined 
templates (please see “Platen Organizer” on page 181). Page layout allows 
using such layout templates to do job placements. 
 
With in the same layout, the jobs placed can have input images having 
various color spaces, e.g. CMYK, sRGB, AdobeRGB, Lab etc. 
 
Page layout feature handles transparent areas of images as well (available 
with PSD or PNG). This means the images can be targeted for different 
colored backgrounds. 

 

Note  
The layout is displayed on pressing <Ctrl>+<L> or by selecting 

Layout > Open Page Layout. 
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More details on what you can do with ‘Page 
Layout’ are given below 

1. Arrange images in a single page regardless of its file format. 

2. Layout images/ jobs each having with its own color profile and color 

space (Like CMYK, RGB, Lab and Multi Channel etc). 

3. Layout the jobs on the page with more accuracy and ease with the help 

of rulers and guidelines. 

4. Open as many numbers of different page layouts template and print 

them one by one with great ease. 

5. Each job in the layout can have its own output parameters (profile, TRC, 

etc), its own underbase settings and its own white highlight settings.  

6. Allows setting placement position for film with in the job platen. If Job 

size is large than the platen size then job is clipped as per the placement 

settings. 

7. Allows the free movement of job within the platen with keyboard and 

mouse. 
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Open Layout Template 

You can create new layout only by opening the saved layout template file, 
created using “Platen Organizer” application. Refer page 181. 
 
You can open layout template file by following ways, 
 

1. Select 'Open layout template' from Layout setting toolbar combo, which is 

shown in below figure. 

Layout List Drop Down Box 

 
2. By selecting Layout > Open layout template command from menu or right 

click context menu > Open layout template in layout view.  

3. By selecting managed layout template file list, which appears clicking on 

quick open button marked as 'B' in below figure. You can manage this list 

using 'Layout Template Management', which appears when you click on 

Template management button Marked as 'A' in below figure. 

 

Managed Layout List 
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Page Layout Controls 

Page Layout 

 
a. Layout Job Transformation toolbar. Refer page 78.  

b. Layout setting toolbar:  We‟ll see detail about it later in this 

section. Refer page 80 for details. 

c. Properties window: Refer page 82. 
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d. Job list view: Job list view contains list of jobs. We‟ll see more 

about it later in this section. Refer page 83. 

e. Layout view: Layout view is the preview of the current layout. It is 

the main working area of the page layout window. We‟ll see more 

about it later in this section. Refer page 84. 

 

Note  

You can create as many layouts as you would like and traverse 

through them using the „layout name‟ combo box in the layout tool 

bar. 

 

Layout Job Transformation Toolbar 

Layout Job Transformation Toolbar 

 

a. Add new Job in layout. The selected Job in the layout list view will 

be added.  

b. Delete selected Job(s).This will delete the all selected Jobs of 

layout.  

c. Link/ Unlink the selected Jobs : 

 

When selected Job(s) are linked with native document then icon 

marked as 'a' is set and if not then icon marked as 'b' is set for 

button. In multiple selection if some Jobs are linked and some are 

not then icon marked as 'c' is set for button.  
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d. Show/ Hide the bounding box: 

 

When bounding box around the selected Job(s) are visible then icon 

marked as 'a' is set and if not then icon marked as 'b' is set for 

button. In multiple selections if bounding box of some Jobs 

are visible and in some jobs are not visible not then icon marked as 

'c' is set for button.  

e. Mirror the selected Job(s).  

f. Scale the selected Job.  

g. Change Job printing setup to custom.  

h. Change Job placement and other settings.  

i. Color garment background visualization color.  

j. Sync/ Un-sync selected job(s) with working or current base type 

printing settings. 

 

 

When selected Job(s) are synchronized with current base type 

printing settings then icon marked as 'a' is set and if not then icon 

marked as 'b' is set for button. In multiple selection if some Jobs 

are synchronized and some are not then icon marked as 'c' is set for 

button.  

k. Rotate job(s) by 90 degree clockwise.  

l. Rotate job(s) by 90 degree counter clockwise.  

m. Rotate job(s) by 180 degrees. 

 

Note  
All the operations mentioned will be applied to all the selected jobs 

in particular layout. 

 
Note  You can not delete or move the platens in the Page Layout. 
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Layout Setting Toolbar 

Layout Setting Toolbar 

 

a. Open the Layout Template. 

b. To remove layout. 

c. To change the default name of the layout. Clicking this, you will be 

presented with „Layout Rename Dialog Box‟. Use it to rename the 

layout. 

 

Rename Box 

 

d. To print the layout by Queue Manager. You can‟t modify the layout 

till it is in the queue manager. 

e. Layout current printing background type: The following drop-down 

list will appear when you click the button. 
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By selecting any printing background type print setting option you can 

make it as current printer settings for layout, so when new job is 

inserted then it takes default printer settings from that current layout 

printing settings. 

f. Zoom In. 

g. Zoom Out. 

h. Open template Organizer application. 

i. It shows the printer driver type selected for the layout. 

j. Layout Name. 

k. Layout template management: It associate generic name with the 

layout template file. 

l. Quick open for managed layout template file(s): The following 

drop-down list will appear as you click the button. 

 

 

This command shows the managed template file list. You can quickly 

open layout template file by selecting given generic name to template 

file path. Also you can browse the template file by selecting 'Open 

Layout Template‟.  

m. Print to file option to print the layout in KPRN files. 

n. Check Overlaps. 
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Properties View 

Properties View 

 

a. Platen Name.  

b. Left-top coordinates of the platen.  

c. Dimension of the platen.  

d. Left-top coordinates of the selection rectangle.  

e. Dimension of the selection rectangle.  

f. Current cursor position.  

g. The ruler offsets are the horizontal and vertical offset of the layout 

rulers from left top margin of the page. 

 

Property window shows some important properties of the selected platen in 
the layout. 
 
At the top it shows the platen name. If multiple or none of the platens are 
selected then it shows appropriate message as per selection type. 
 
Then comes the unit in which all other elements are displayed. Here in this 
example the unit used is inch. You can change unit by selecting required unit 
from right click context menu. 



 

83 

Next Left and Top offset of the selected platen is displayed. These offsets are 
from the left of margin and top margin of the page. Then height and width of 
the selected platen is shown. 
 
Cursor position shows the current cursor position with respect to the ruler. 
The left and top offset of the current platen is also in ruler co-ordinate space. 
 

Job List View 

The job list view on the lower left side of the page layout window shows all 
the jobs present in currently opened documents in Print Pro. This list gets 
updated automatically whenever you open a new document or close an 
already existing one. This view shows only relevant jobs. 

 

Job List View 

 
In the list a document with „*‟ after its name denotes that it is an imported 
document or Unlinked document. 
 
If you try to close a document, which has at least one job present in any of 
the page layouts, Print Pro will warn you about the same and ask for 
permission to close it any way. If you close the document, the jobs from this 
document in all the layouts in which it is present will be removed. 
 
The fly-over tip in the job list view shows the respective job size in inches 
apart from job name and type if the cursor is placed above the job‟s name. 
 
When the cursor is above a document name then fly-over tip shows the full 
path name of the document. If this document is created by Print Pro and you 
have not saved it yet, the tool tip will say that this is „Not a disk file‟. 
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A number inside the braces beside the job name indicates how many copies 
of this job are in the current layout. E.g., “TCROPSEP1.psd (2)” tells that the 
job named „TCROPSEP1‟ has got two copies in the current layout. 
 

Layout View 

The layout view shows preview of the current layout. This shows all the 
job(s) in the page at their respective positions with thumbnail. The gray 
rectangle inside the page indicates the page margin. 

 

Layout View 
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To select a job by the platen or to toggle among several jobs in the layout 
view you can either click on the Job or use the <Tab> key. 
 
To move a job, drag the job while holding the <Ctrl> key. Or use < Up > or 
<Down> or <Left> or <Right> keys. 
 
To change print options Use <Alt> + <Enter> keys simultaneously to get the 
print option property sheet of the selected job. In this property sheet only 
those options relevant to the layout is enabled. 
 
By right click on the job you can scale, translate and rotate in step of 90°. 
(Popup menu > Scale This Job…). Use the handles around the job to move 
its edges. Drag inside the bounding box to move the job. While dragging to 
restrict the movement to steps of 45° hold <Shift>. While dragging an edge 
of the bounding box use <Shift> to maintain the aspect ratio and use <Alt> 
to get reflection around the center. You can also move the center if you 
want. 

 

Transformation of Job 

 
You can scale the image on a selected platen by double clicking on it while 
holding the <Ctrl> key.  
 
During transformation operation you can cancel it by pressing <Esc> key or 
using menu command   Right click > Cancel Transformation. To commit a 
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transformation use <Enter> key or double click inside the bounding box or 
use command Right click > Apply Transformation. 
 
Job in the layout can be rotated in steps of 90°. To rotate a job use the right 
click menu commands or during transformation of job rotate using mouse 
move.  
 
Initially the ruler origins are aligned with page margins (left and top). You 
can change this origin by dragging the cursor from the box marked as ‘A’ in 
the figure above named as "Layout View". To reset the origin to the left top 
of page margin double click in „A‟. 
 
To create guide Drag the cursor from the horizontal or vertical ruler and drop 
in position where you want the guide. You can use <Alt> key to rotate the 
guide 90°. You can also add a guide by using the menu command View > 
Guides > New Guides…  
 
To move a guide Drag the guide while holding <Ctrl> key.  
 
To delete a guide Move the guide out of the page. To delete all the guides 
use menu command View > Guides > Clear Guides. 
 

Moving in between job list view & layout view: 

 
Using Keyboard:  
 
Use <Spacebar> + <Tab> keys to move to and fro.  
 
Using Mouse:  
 
Click on the appropriate view. 

 

Note  
You can not Move, Delete or Copy platen(s) in layout view. 
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Using Layout Option 

Layout Option Box 

 

a. Check to show bounding box around the platen.  

b. Normal: Non-selected platen bounding box color.  

c. Selected: Selected platen bounding box color.  

d. Focused: Focused platen bounding box color.  

e. New Job remains linked to native document or unlinked when 

inserted into layout.  

f. Show unlinked document into tree: This option allows you to 

show or hide unlinked document into the job list view. When 

unlinked document is visible into job list view you can add new Jobs 

of that unlinked document into another layout. 
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Know the Important Menus and Submenus for 
Page Layout 

Layout Menu 

 
a. Printer Setup: Using this command you can change printing 

settings for each background type. 

b. Job Print Setup: Using this command you can synchronize 

selected jobs with any of the printing background type printing 

settings or set customized printing settings. 

c. Open/Close Page Layout: To show and hide the page layout. 

Shortcut <Ctrl>+<L>. 

d. Add Job: Clicking on this menu will add a single copy of the 

selected original image into all the selected platen(s) in current 

Layout. Refer to the following figure for better understanding. If you 

want to add the image two times, you have to click on this 

menu two times. This function can also be achieved by pressing the 

<Insert> key. 
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Job List View for Composites 

 

e. Delete Job: To delete the job/s in your layout, press <Ctrl> 

and left click on the image that you want to remove/ delete from 

layout. The particular image will be selected. Then, press „Delete‟ 

button. The job will be removed from the layout. You can also press 

the <Del> key.  

f. Unlink from native doc: Using this command you can link/unlink 

the selected job(s) with the native doc. 

g. Show/Hide Bounding box: Using this command you can 

show/hide bounding box of selected platens. 

h. Rotate: Using this command option you can rotate selected job(s) 

in 90 degree clock wise, 90 degree anti clock wise and 180 degree. 

i. Layout Print Setup: When you click on this menu item it shows 

the current printing base type printer setup settings. 

j. Layout Template Manager: When you click on this menu item it 

shows Layout Template Management dialog.  

k. Open Layout Template: Using this command you can open saved 

layout template file. 

l. Delete Layout: This command delete the current layout. 

m. Select Layout: When you click on this menu item it drop down the 

layout list combo in Layout setting tool bar. 

n. Check Overlaps: This menu will help to ascertain if there is any job 

overlaps in the current layout. When you will click on this menu, it 

will show message box „Overlap found‟ OR „No overlap found‟ for the 

current page layout. 

o. Layout Option: Refer “Using Layout Option” on page 87. 
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  Commands   Short Keys 

Open / Close Page Layout  Ctrl + L 

Open Layout Template  Ctrl + Shift + O 

Adding up job in layout  Insert 

Delete a job  Del 

Select a job in layout  Ctrl + Left Click on that particular job 

Select layout  Ctrl + F 

Check overlap  Ctrl + C 

Zoom In  Ctrl + + 

Zoom Out  Ctrl + -- 

Print Layout  Ctrl + P 

Layout Print Setup  Ctrl + Shift + P 

Job Property  Alt + Enter or Shift + Double click on job  

Select All job(s)  Ctrl + A 

Deselect all job(s)  Ctrl + D 

List of Shortcuts 
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Adding jobs to the Layout 

By dropping the necessary files from the Windows Explorer or from the „File 
Browser‟ tab into the layout. This will add job into job list view. 
 
New job is added into all the selected platen(s). 
 

a. By double clicking on the appropriate job from the list on the left 

pane. 

b. Selecting the job and clicking „Add‟ button on the layout tool bar. 

c. Selecting the job and pressing <Enter>. 

d. Selecting the Job and pressing <Insert>. 

e. By Dragging the Job from Job list view and Dropping on the Platen. 

 

These controls will remain disabled initially because there are no jobs 
selected in the job list. You can determine a job‟s size in inches from the fly-
over tip by placing the mouse cursor above the job name in the job list view. 

 

Note  
If any job is already present into platen and you add new job 

on that platen, then previous job is automatically deleted. 

 

Placing a job in the Layout View 

Adding a job places it in selected platen. Then you can move it to anywhere 
within the platen rectangle. 
 
Use zoom-in and zoom-out commands on the layout tool bar to get a proper 
view of the page in use.  
 
To move a job by using the keyboard, you need to select it first. Then use 
the arrow keys in your keyboard to move the selected job in appropriate 
direction. For faster displacement, use <Shift> key in combination with these 
keys. 
 
If you want to use the mouse, click the left mouse button inside the desired 
job rectangle and drag it with mouse button still down to the location of your 
wish. 

 

Note  
Print Pro constraints the placement of the job within the platen 

rectangle. 
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Selecting a job in the Layout View 

Using Keyboard:  
 
You can navigate through the jobs by pressing the <Tab> key. Press <Shift> 
+ <Tab> to navigate in the opposite direction. 
  
Using Mouse:  
 
Click inside the rectangle that represents the desired job. Press <Shift> key 
along while clicking to select a job that is hidden (overlapped) by another 
job. 
 
Selecting multiple jobs: 
 
Press <Shift> key along with <Ctrl> and mouse click to select multiple jobs. 
You can also use <enter> key while moving between the jobs using the 
<tab> or <shift>+<tab> key to make multiple selections.  
 
You can also use <ctrl>+<A> to select all the jobs in the layout. You can use 
<ctrl>+<D> to deselect the jobs. 
 
You can also select multiple jobs by drawing a selection rectangle starting 
form the blank space in the layout while holding the <ctrl>key down. All the 
jobs having at least 8% of their area in the selection rectangle get selected. 
 
You can also toggle the selection status of the jobs inside the selection 
rectangle by holding the <shift> key down in the operation as described 
above. 
 
While performing any select operation with <shift> key down, it results in 
toggling the selection status of the job in question. 
 
Multiple selections allow you to align various jobs with respect to each other. 

 

Note You can delete selected job(s) by using the <Del> key. 
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Snapping 

To place job(s) and guides easily Print Pro snaps the moving guide to the 
nearest hot edge. In case of guide movement this hot edge is the nearest 
border or halfway mark of a Platen.  This snapping facility for the current 
moving object can be overridden holding <shift> while dragging the guide. 
 

Open Document from Job List View 

When ever you are importing image or unlink job(s) from native document in 
layout the newly imported/created document is shown into job list view 
(Unlinked shown only when 'Show unlinked document into tree' option is 
checked in Layout Option). But if you want to perform operation(s) on that 
document, like applying filter, changing printer settings, then you need to 
open that document. 

Open Document from Job List View 

 
To open imported document or unlinked document (marked with '*' in Job 
list view), right click on the document name shown into the job list 
view. This will show the context menu to open document, which is shown in 
the above figure. 
 
By selecting menu item 'Open Document', the selected document will be 
opened into the application. 
 
This feature is helpful when you have applied some filters on job and that job 
is unlinked. Now you want that document for further use, then by opening 
document from job list view you can perform operation on it. 
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Channel Palette in Layout 

By using channel palette in layout you can change the channel visibility, 
channel type related data of the selected job(s). 

Channel Palette in Page Layout 

 
You can change channel type of selected job(s) by selecting option from the 
right click context menu on the channel in channel palette as shown in the 
above figure. 
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Printing a Layout 

To print the currently active layout, click „Print‟ on the layout toolbar or 
select Layout > Print layout command. If you want to output to a file instead 
of a printer, check the „Print to file‟ box in the layout toolbar. 
 

Print Option for Layout 

Print option allows you to set placement setting, size and other printing 
related option for selected job. 

 

Print Option Box 

 

a. As In Document: Set job sizes same as document size. 

b. 1 to 1 (Printer Resolution): This option is not allowed in layout. 

c. Fit to page: Set job sizes same as platen size. This option fit the 

job size into platen. 

d. Custom: You can set size, scale factor manually. 
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e. Position: Placement position of job. 

f. Custom Placement Position: You can set placement settings as 

per your requirement. In layout negative placement is allowed. You 

can set placement setting within the allowed range such that job 

does not goes out side the platen rectangle. 

 

Layout Print Settings 

Printing setting of each background type need to set appropriately otherwise 
you are not able to print layout. 
 
Here you can change each base printer settings by selection appropriate 
base settings option from menu.  If you select option from Layout setting 
tool bar button then current printer setting base is changed and it shows on 
the button.  But if you select option from right click context menu then active 
base type setting is not changed. 
 

Here, Black Base, White Base, Color Base and Dark Color Base settings 
options are available for garment printing. 
 
In each background base settings printing base in device option tab must be 
set as per the option name. 

 

Note 

If you change inkset related settings, port settings and other 

printing parameters then it is reflected into other three printing 

background printer settings. 

 
The dialog in the following page shows the four different kinds of print 
settings as you click on the „Print Setup‟ button on the layout setting toolbar. 
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Print Setup Button on Layout Setting Toolbar 

 

a. Black base settings: Change the print settings for black garment.  

b. White base settings: Change the print settings for white garment.  

c. Color base settings: Change the print settings for color garment.  

d. Dark Color base settings: Change the print settings for dark color 

garment (Optional feature in the basic version of the software). 

Right Click Context Menu 

 

When ever you are printing layout and if printing settings are not appropriate 
then you get the error message and based on that error message you can 
identify that which printing background settings are not match and which 
field is not appropriate in that printing settings. 
 
Here from printing settings dialog you can not change the page size and 
other parameters which affect page size. 

 

Note 

In case of „Page Layout‟ you can not change the Page size of 

layout any way. All the controls in „Print Setup‟ will remains 

disabled which affects the page size of the layout. 
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Job Printing Settings 

Job print settings command allows you to set printing settings for job as per 
printing background type. 
 
Job print settings allows you to set printing background, printing Media type, 
Printer profile, TRC curves, color correction data and printing background 
related data for each job. 
 
You can use printer settings of layout for job directly, by selecting printing 
background type settings option from job print settings menu as per required 
printing background type. 
 
If you are using any layout printer settings for job then when any change 
made in the printing settings of layout then it is automatically reflected into 
the job print settings. For e.g. Job is using white base type settings and you 
change any parameters in white base type print settings of layout then it is 
reflected into job printing settings. 

 

Screen Print Setup Option in Menu 

 
If you select custom print settings for job then you can specify printing 
related parameters individually for each job. 
 
You can set custom settings by selecting 'Use custom print setup...' from 
menu or clicking on the layout job transformation button, shown in below 
figure with circle around it. 

 

Custom Print Setup for Job 
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When you select 'Use custom print settings' it shows the printing setting 
dialog. Using that dialog you can change printing related settings for job. 
 

Custom Print Properties for Job 

Print Environment Page for Job Print Setup 
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a. Media type: Specifies the media on which user wants to print. This 

can be a user created media or a predefined media. Basically by 

selecting a new media user selects a new ICC profile and TRC 

curves for printing which was selected by the user while creating 

that media. Media type can be dependent on ink type or can be 

independent depending on the printer selected. If a media type is 

dependent on ink type then only those media are shown which the 

selected ink type supports. User can still override the ICC profile or 

the TRC curve used by selecting appropriate files using „Load TRC…‟ 

and „Load ICC…‟ buttons.  

b. Ink type: Shows the list of ink type supported by the printer. Many 

printers have media type dependent on ink type i.e. for one media 

type you may want to select the different TRC curves and ICC 

profile and for other ink type a different set.  

c. Create Media: This button is used to create a new media or 

remove a media created. Refer page 58 . 

d. Check bar options: Use this button for the alignment of bars. 

Refer page 59. 

e. Load TRC: Use this option to change the TRC curves used for 

printing an image.  

f. Load Printer Profile: Use this option to select a different printer 

profile for printing. Remember always load the same number of 

channel printer profile as in the currently loaded inkset.  

g. Load White TRC: Use this option to change the TRC curves used 

for printing the white base for an image.  

h. Printer Profile: It shows the currently loaded printer profile name.  

i. Horizontal Size change by addition processing.  

j. Vertical Size change by addition processing.  

k. Use default: This command loads the default settings, which are 

same as the layout printer settings as per the current printing 

background type. 

 

Color Correction Page 

See “Color Correction Page” for more detail on page 64. 
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Device Options for Job Printer Settings 

Device Options for Job Print Setup 

 
a. Underbase option: This underbase option will allow you to select 

whether the printing are for white underbase printing or for color 

data printing. This option is disabled when the printing is on white 

printing base (see b) has been set.  
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b. Printing base: It allows you to select the color of the printing 

base. It can be any one of the following - 

1. White  

2. Black  

3. Color  

4. Dark Color (Optional Feature in the basic version of the 

software). 

 

c. Highlight Generator: There are four options from which you can 

choose the best one for your printing needs - 

1. None: If you don't want to use "Highlight Generator" 

during printing then select this option.  

2. Channel Based:  Highlight option will work as usual using 

the channels. Fuzziness value is disabled and ignored.  

3. On the fly:  The RIP will generate the white highlight on 

the fly during ripping using the fuzziness value that you 

supply there. This will ignore any highlight channel set 

otherwise in the channel palette. The fuzziness value works 

similar to the highlight channel creation option.  

4. Combine:  The RIP will generate the white highlight on the 

fly during ripping using the fuzziness value that you supply 

there and will combine it with the highlight channels set in 

the channel palette. The fuzziness value works similar to 

the highlight channel creation option. 

 

d. Highlight Fuzziness: The fuzziness value works similar to the 

highlight channel creation options. This will be disabled in the case 

of Channel based Highlight generator.  

e. Strength:  As the name suggests the strength option is to control 

the amount of application of each individual option. 0% means no 

strength and 100% means full strength. In past whatever you may 

have created and used with the software was at full strength i.e. 

100%. Now you could control the application of the amount of the 

feature. For example if you use the Choke Strength to be 50% then 

the choking will be applied by 50% amount of the gray value in the 

corresponding channel. Similarly, if you use the Underbase 

Strength to be 50%, the underbase that will be printed will be half 

the strength that otherwise would be printed when this value is 

50%.  
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f. Use Default:  Load the default settings for Job print setup. 

 

Note 

If multiple Jobs are selected then focused job's printing data is 

filled into above dialogs for displaying. Also when settings are 

applied then all the selected job's printing settings changed as 

per the new settings. 
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Filters 

What are Adjustment filters? 

These filters make adjustments in the pixel color, based either some 
statistical property of the image or on its color value or a combination of 
both. 
 
Print Pro offers the following two types of filters: 
 
A. Based on statistical information of the image: 

1. Levels 

2. Auto Levels 

3. Auto Contrast 

4. Curves 

5. Equalize 

6. Threshold 

 

B. Based on the pixel color value: 

1. Brightness / contrast 

2. Color Balance 

3. Hue / Saturation / Lightness 

4. Desaturate 

5. Channel Mixer 

6. Invert 

7. Posterize 

8. White Highlight Channel 

9. White Underbase Choke Mask 

10. Add Transparency channel 

 

C. Histogram: Technically not a filter, but only displays the statistical 

information of the image. 
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In General, filters with tunable properties will show an options dialog, where 
you can fine tune the filter‟s specific option(s). Each such options dialog will 
have a preview checkbox in common as shown in the figure below.  

 

 
Check this box to view the effect of the settings in the options box online. 
 

Making Color Adjustments 

You can access these filters by invoking the appropriate submenu from the 
Adjustment menu or alternatively by using the appropriate shortcut key. 

 

Adjustment Menu 

 

The following details regarding each of these filters will help you in choosing 
what filter to apply. 
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Levels 

You can correct the tonal range and color balance of an image by adjusting 
the levels of intensity of the image‟s shadows, midtones and highlights. 
Levels dialog can visually guide you to adjust the important tones in an 
image. You can also save and load a particular set of levels parameters from 
within the dialog. 

 
Choose Adjustment > Levels… or the keyboard shortcut <Ctrl>+<E> to 
open the levels dialog box shown below.  

 

Level Adjustment Dialog 

 

a. Output slider  

b. Image level histogram 

c. Input slider 

 

Using Levels to set highlights, shadows, and midtones: 
 
By moving the inputs sliders, you can set the highlights and shadows in an 
image to the first group of pixels on both ends of the Levels histogram. This 
results in the mapping of these pixels (the darkest and the lightest) to black 
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and white, increasing the tonal range of the image and improving the overall 
contrast. For making adjustments to the midtones intensity values use the 
middle Input slider. 

 

Levels Filter Sample 

 

To adjust tonal range using levels: 
 
1. Invoke the levels dialog box. 

2. To adjust tones for a specific color channel, choose an option from the 

Channel menu.  

3. To adjust the shadows and highlights, do one of the following:  

 Drag the black and white Input Levels sliders to the edge of the first 

group of pixels on either end of the histogram. You can also enter 

values directly into the first and third Input Levels text boxes. 

 Drag the black and white Output Levels sliders to define new 

shadow and highlight values. You can also enter values directly in 

the output levels text boxes.  

 

For example, suppose your image pixels cover only the range 0-X for 

some X < 255. If the input slider is dragged to X, pixels with intensity 

values of X and higher are mapped to 255; pixels with lower intensity 

values are mapped to corresponding lighter values. This normalization 

lightens the image, increasing the contrast in highlight areas. 

 

Suppose instead you want to decrease the contrast in the image then 

you will have to drag the Output Levels slider to X, pixels with intensity 

values of 255 are remapped to X, and pixels with lower intensity values 
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are mapped to corresponding darker values. By doing this, you will 

darken the image because of decrease in contrast in the highlight areas. 

 

4. Click OK.  

5. To view the adjusted histogram, reopen the Levels dialog box or open 

the Histogram Dialog Box. 

 

Auto Levels 

This filter will automatically set the shadows and highlights in an image. It 
defines the lightest and darkest pixels in each color channel as white and 
black and then redistributes intermediate pixel values proportionately. Since, 
this filter manipulates each channel individually it might introduce or 
eliminate color casts.  Auto Levels gives good results when an image with an 
average distribution of pixel values needs a simple contrast adjustment or 
when an image has an overall color cast. 
 
Choose Adjustment > Auto Levels or keyboard shortcut <Shift> + <Ctrl> + 
<E> to apply auto-levels to an image. 
 
The effect of applying the Auto Levels is shown in the following figure. 

Auto Levels Filter Sample 
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Auto Contrast 

The Auto Contrast command adjusts the overall contrast and mixture of 
colors in an image automatically. Since auto contrast filter does not 
manipulate individual channels it won‟t eliminate or introduce color casts. 
After applying this filter, highlights will become lighter and shadows will 
become darker. 
 
Auto Contrast can improve the appearance of many photographic or 
continuous-tone images. It does not improve flat-color images. 
 
To use the Auto Contrast command: 
 
Choose Adjustment > Auto Contrast or the keyboard shortcut <Alt> + 
<Shift> + <Ctrl> + <E>. 
 
The effect of applying the Auto Contrast is shown in the following figure: 

 

Auto Contrast Sample 
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Curves 

Like the Levels dialog box, the Curves dialog box lets you adjust the entire 
tonal range of an image. However, instead of making adjustments using only 
three variables (highlights, shadows, midtones), with Curves you can adjust 
any point along a 0-255 scale while keeping up to 16 other values constant. 
Using curves you can make accurate changes to individual color channels in 
an image. You could save the currently defined curve or load a previously 
saved curve from within the dialog.  
 
Choose Adjustment > Curves... or the keyboard shortcut <ctrl> + <shift> + 
<M> to invoke the curves dialog. The dialog is shown as follows: 

 

Curves Dialog 

 
a. Click here to select a particular channel.  

b. Click here to draw the curve in free hand using the mouse. 
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To adjust the color balance of the image, choose the channel (or channels) 
you want to adjust from the Channel menu. 
Do any of the following to adjust the curve: 
 
1. Click on the curve to define the point and move the points around for 

changing the shape of the curve. 

2. You can use the pencil tool provided in the dialog box to draw the curve 

using the mouse. 

 

Equalize 

The Equalize command redistributes the brightness values of the pixels in an 
image so that they more evenly represent the entire range of brightness 
levels. 
 
You might use the Equalize command when a scanned image appears darker 
than the original and you want to balance the values to produce a lighter 
image. You could use equalize and histogram in combination to compare the 
brightness before and after applying equalize filter. 
 
To use the Equalize command: 
 
Choose Adjustment > Equalize… 
  

Threshold 

The Threshold command converts grayscale or color images to high-contrast, 
black-and-white images. You can specify a certain level as a threshold. All 
pixels lighter than the threshold are converted to white; all pixels darker are 
converted to black.  
 
To use this command: 
 
Choose Adjustment > Threshold… 
 
To use the Threshold command to convert images to black and white: 
 
Open the Threshold dialog box. 
 
The Threshold dialog box displays a histogram of the luminance levels of the 
pixels in the current image. 
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Threshold Dialog 

 
Drag the slider below the histogram until the threshold level you want 
appears at the top of the dialog box, and click OK. 
 

Brightness / Contrast 

The Brightness / Contrast command lets you make simple adjustments to 
the tonal range of an image. Unlike Curves and Levels, this command makes 
the same adjustment to every pixel in the image. The Brightness / Contrast 
command does not work with individual channels and it is advisable not to 
use it for high-end output because there could be a loss in the image details.  
 
To use the brightness/contrast command: 
 
Choose Adjustment > Brightness/Contrast... 
 
The following figure shows the Brightness / Contrast dialog box. 
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Brightness / Contrast Dialog 

 

Color Balance 

The Color Balance command changes the overall mixture of colors in an 
image for generalized color correction. 

Color Balance Dialog 
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a. Select the tonal range to be changed from here. 

 

You can access this filter by the following mentioned path: 

 

Choose Adjustment > Color Balance… or the keyboard short-cut <ctrl> + 

<B>. 

 

To use the Color Balance command: 
 

 Make sure the composite channel is selected in the Channels 

palette. This command is available only when you're viewing the 

composite channel e.g. RGB and not R & B alone.  

 Open the Color Balance dialog box. 

 Select Shadows, Midtones, or Highlights to select the tonal range on 

which you want to focus the changes. 

 Select Preserve Luminosity to prevent changing the luminosity 

values in the image while changing the color. This option maintains 

the tonal balance in the image. 

 Drag a slider toward a color you want to increase in the image; drag 

a slider away from a color you want to decrease in the image. 

 You can also provide values for the parameters in the text box 

provided alongside every slider. 

 

Hue/Saturation/Lightness Adjustment 

The Hue/Saturation command lets you adjust the hue, saturation, and 
lightness of the entire image or of individual color components in an image. 
 
There are two ways this filter could be used: 

 

1. To give a tint to the whole image.  

2. To adjust the hue/saturation.  
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To use this filter: 
 
Choose Adjustment > Hue/Saturation… or using the keyboard short-cut 
<ctrl> + <U>. 

 

Hue/Saturation/Lightness Dialog 

 
To use the Hue/Saturation command: 
 

1. Open the hue/saturation dialog box. The two color bars in the dialog box 

represent the colors in their order on the color wheel. The upper color 

bar shows the color before the adjustment; the lower bar shows how the 

adjustment affects all of the hues at full saturation. 

2. For Edit, choose which colors to adjust:  

 Choose Master to adjust all colors at once.  

 Choose one of the other preset color ranges listed for the color you 

want to adjust. An adjustment slider appears between the color 

bars, which you can use to edit any range of hues.  

 If you tick the colorize option, you won‟t be able to make 

adjustments for individual hue areas.  
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3. Tick the colorize option to give a tint to the image. 

4. For Saturation, enter a value or drag the slider to the right to increase 

the saturation or to the left to decrease it. Values can range from -100 

to +100. 

5. For Lightness, enter a value or drag the slider to the right to increase 

the lightness or to the left to decrease it. Values can range from -100 to 

+100. 

 

To modify the range of an adjustment slider: 

 

1. Choose an individual color from the Edit menu in the dialog box.  

2. Do any of the following to the adjustment slider:  

 Drag one of the white bars to adjust the amount of color fall-off 

without affecting the range.  

 Drag the area between the triangle and the vertical bar to adjust 

the range without affecting the amount of fall-off.  

 Drag the center area to move the entire adjustment slider, selecting 

a different color area.  

 Drag one of the vertical white bars next to the dark gray area to 

adjust the range of the color component. Increasing the range 

decreases the fall-off, and vice versa.  

 Ctrl-drag the color bar so that a different color is in the center of 

the bar. 

Adjustment Slider Dialog 

 

a. Adjusts fall-off without affecting range.  

b. Adjusts range without affecting fall-off. 

c. Moves entire slider. 

d. Adjusts range of color component. 

 

3. To edit the range by choosing colors from the image, select the 

eyedropper tool  in the dialog box and click in the image. Use the 
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eyedropper + tool to add to the range; use the eyedropper - tool to 

subtract from the range. 

 

Note 
Always select the Eyedropper from the Tool Palette before 

editing the range of colors from the image. 

 

Desaturate 

The Desaturate command converts a color image to a grayscale image in the 
same color mode. For example, it assigns equal red, green, and blue values 
to each pixel in an RGB image to make it appear grayscale. The lightness 
value of each pixel does not change. 
 
This command has the same effect as setting Saturation to -100 in the 
Hue/Saturation dialog box. 
 

To use the Desaturate command: 
 
Choose Adjustments > Desaturate or the keyboard shortcut <shift> + 
<ctrl> + <U>. 
 

Channel Mixer 

The Channel Mixer command lets you modify a color channel using a mix of 
the current color channels. With this command, you can do the following: 
 
 Make creative color adjustments not easily done with the other color 

adjustment tools. 

 Create high-quality grayscale images by choosing the percentage 

contribution from each color channel. 

 Create high-quality tinted images. 

 Swap or duplicate channels. 

 

To mix color channels: 
 

1. In the Channels palette, select the composite color channel. 
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2. Choose Adjustment > Channel Mixer… 

 

Channel Mixer Dialog 

 

3. For Output Channel, choose the channel in which to blend one or more 

existing (or source) channels. 

4. Drag any source channel's slider to the left to decrease the channel's 

contribution to the output channel or to the right to increase it, or enter 

a value between -200% and +200% in the text box. Using a negative 

value inverts the source channel before adding it to the output channel. 

5. Drag the slider or enter a value for the Constant option. This option adds 

a black or white channel of varying opacity; negative values act as a 

black channel, positive values act as a white channel. 

6. Select Monochrome to apply the same settings to all the output 

channels, creating a color image that contains only gray values. 

 
Use the Channel Mixer with the Monochrome option applied to control the 
amount of detail and contrast in the images you plan to convert to grayscale. 

 
If you select and then deselect the Monochrome option, you can modify the 
blend of each channel separately, creating a tinted appearance. 
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Invert 

The Invert command inverts the colors in an image. You might use this 
command to make a positive black-and-white image negative or to make a 
positive from a scanned black-and-white negative.  
 
When you invert an image, the brightness value of each pixel in the channels 
is converted to the inverse value on the 256-step color-values scale. For 
example, a pixel in a positive image with a value of 255 is changed to 0, 
and a pixel with a value of x to 255-x. 
 
To use the Invert command: 
 

Choose Adjustment > Invert or by using keyboard shortcuts as <Alt> + 
<Ctrl> + <I>.  
 

Posterize 

The Posterize command lets you specify the number of tonal levels (or 
brightness values) for each channel in an image and then maps pixels to the 
closest matching level. For example, choosing two tonal levels in an RGB 
image gives six colors, two for red, two for green, and two for blue. 
 
This command is useful for creating special effects, such as large, flat areas 
in a photograph. Its effects are most evident when you reduce the number of 
gray levels in a grayscale image. But it also produces interesting effects in 
color images. 

 

Posterize Dialog 
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To use the Posterize command: 
 
Choose Adjustment > Posterize...  and enter the number of tonal levels you 
want and click OK. 

 

White Highlight Channel Creator 

White Highlight Channel Creator 

 
To use the White Highlight Channel creator command: 
 
Choose Image > Add White Highlight Channel... 
 

Strength as the name suggests the amount by which to reduce the gray 
value representing the amount of white ink for the pixel under consideration. 
This value is constant for all the pixels of the image. 100% represents full 
strength, whereas 0% represents no inking. 
 
Fuzziness determines the selection of the colors that are near to white. Large 
value will include more colors that are away from white. 
 
Usually a Fuzziness value of 15 and strength value of 255 works well for 
most classes of images. 
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White Underbase Choke Mask Channel 

To use the choke feature: 
 
1. Load any image.  

2. Select the correct printing mode. Please note in case of black 

background, the profile also has an impact on the choke mask 

generated. 

 

Choose Image > Add WhiteUnderbase choke... 
 

You will get the dialog that will help you create the boundaries. 
 

White Underbase Choke Mask Channel Creator 

 
Choke boundary can be defined as number of pixel wide. This number can be 
in fraction of the pixel. The white pixels edges in the image are however 
spared from being choked. See the example image below. 
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Sample Test Image 

 

Advance Dialog 

By default white pixels are defined as RGB 255,255,255. You can specify the 
starting values in the Advance dialog as shown below. In that case the white 
pixels will be defined as per range from the RGB value defined in the 
Advance dialog box to RGB 255, 255, 255. 

 

White Area Cut Offset 

 

Note 

On the Device Option tab of the printer properties dialog, there 

is a setting that can be used to control the strength of the 

choke. The range is between 0....255. 255 is the maximum 

choke strength. 
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Note 

You can create multiple choke channels and combine them by 

setting their visibility on. Print Pro will combine these channels 

into the single choke channel during the print. 

 
If you want to mask the white underbase in some portion of image then 
„White underbase choke mask‟ is useful. Create spot channel on the portion 
where you do not want to apply the choke and make that channel as „white 
underbase choke mask‟. Now add new white underbase choke mask channel 
and tick the „Use white underbase choke mask‟ to mask the portion of image 
for white underbase where white underbase choke mask is present. 
 

Add Transparency Channel 

Transparent images are useful when you are not certain of the page 
background color on which your image will be displayed, or you intend to 
display your image in front of a complex background rather than a single 
background color. It also helps you to knock out some colors which you don‟t 
want to print on image without the intervention of other software. 
 
To use this tool, either go to Image > Add Transparency Channel or press   
<Ctrl> + <Shift> + <T>.  The following dialog will be prompt. 

 

Add Transparency Channel 

 
In this dialog, you can select the color that you want to make transparent by 
clicking on the color bar shown in the dialog. The color picker dialog will be 
popped-up in which you can select the color from the color window, or 
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manually enter the color values. Instead of remembering the color values, 
simple press the <Ctrl> key. The eyedropper is ready to pick the color from 
the image and drag it on the color bar of the dialog box.  
 
Strength: Strength is defined as transparency depth. Using this you can 
make the selected color portion 100% transparent by entering 100 in 
strength edit box or semi – transparent by entering 50 in the strength edit 
box. 
 
Fuzziness: Enter the value for color distance from 0 to 200. Enter the low 
value (say 0) to match the exact color value that you want to make 
transparent. Higher value will make the broader range of selected color to be 
transparent. 
 
On pressing the “OK” button, one channel named as “Transparency1” will be 
created in the channel palette.  
 

Consider the image.  
 

Image With Transparent Channel 

 
If you want to print on any color substrate, the white background will be 
printed which looks like the patch in the printing. To avoid this type of the 
printing problem, knock off the white background using this tool. 
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Histogram 

Other than Filters the Adjustment menu has one more command of 
“Histogram”. 
 
A histogram illustrates how pixels in an image are distributed by graphing 
the number of pixels at each color intensity level. This can show you whether 
the image contains enough detail in the shadows (shown in the left part of 
the histogram), midtones (shown in the middle), and highlights (shown in 
the right part) to make a good correction. 
 
Choose Adjustment > Histogram  

 
The histogram gives a quick picture of the tonal range of the image.  The 
following diagram shows an image and its corresponding histogram. If you 
hover the mouse pointer over the histogram you will see the corresponding 
statistics of that portion of histogram. You can also select a portion of the 
histogram to see the statistics of that selected portion. 

Histogram 

 
Statistical information about the intensity values of the pixels appears below 
the histogram: 
 

1. Mean: Represents the average intensity value.  

2. Standard deviation (Std Dev): Represents how widely intensity values 

vary.  

3. Median: Shows the middle value in the range of intensity values.  

4. Level: Displays the intensity level of the area underneath the pointer.  
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5. Count: Shows the total number of pixels corresponding to the intensity 

level underneath the pointer. 

6. Percentile: Displays the cumulative number of pixels at or below the 

level underneath the pointer. This value is expressed as a percentage of 

all the pixels in the image, from 0% at the far left to 100% at the far 

right. 

7. Pixels: Represents the total number of pixels used to calculate the 

histogram. 

8. Cache Level: Shows the setting for the image cache. If the Use Cache 

for Histograms option is selected in the Memory and Image Cache, the 

histogram displays more quickly and is based on a representative 

sampling of pixels in the image (based on the magnification), rather 

than on all of the pixels (equivalent to a cache level of 1). Deselect this 

option if you want to check for posterization in the image.  
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The Application Interface 

In this chapter, we will look at the general interfaces and other features 

offered by Print Pro for carrying out the task of printing images. 
 

The Application Window 

Application Window 

 
a. Menu bar. 

b. Tool bar. 

f 
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c. Tool Palette (Eye Dropper, Selection Tool, Pan tool, Zoom tool). 

d. Design Window: Shows the composite design output. Right click 

anywhere on the window to get the access to list of commonly used 

commands. 

e. Application background: Double click here to get the „File Open Box‟. 

f. Channel Palette: Lists all the channels present in the design. 

 

Menu Bar 

List of commands offered by Application „Menu bar‟. 
 

File Menu Commands 

File Menu 
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a. Open: Open a design document. Refer „File Format Support‟ on 

page 163. 

b. Save As: Save the design document in either of bmp, Jpeg, Pcx, 

Png, Psd, Tiff or Tga format. 

c. Close: Close the active design document.  

d. Load Print Settings: Load Printer settings from the file for the 

active design document.  

e. Save Print Settings: Save Printer settings of the active design 

document to a file. Refer „About PST Files‟ on page 164. 

f. Save Print Settings As: Enables saving printer settings with 

another name. Refer „About PST Files‟ on page 164. 

g. Print: Print the active design document.  

h. Print Preview: Preview the active design document, with page 

layout etc.  

i. Print Options: Print settings for the active design document.  

j. Print Setup: Printer settings.  

k. Recent active windows: Last accessed design documents.  

l. Exit: Exit Print Pro. 

 

Edit Menu Commands 

Edit Menu 

 
a. Undo / Redo: Use this command to restore the change, when any 

filter is applied on the image.  

b. Step Forward: To get the next series of changes applied by filters 

on any image.  

c. Step Backward: To get the previous series of changes applied by 

filters on any image. 
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Image Menu Commands 

Image Menu 

 
a. Rotate 90 CW: Rotate the image by 90 degrees in Clock Wise 

direction. A new document is created in this case.  

b. Rotate 90 CCW: Rotate the image by 90 degrees in Counter Clock 

Wise direction. A new document is created in this case.  

c. Rotate 180: Rotate the image by 180 degrees. A new document is 

created in this case.  

d. Rotate...: Rotate the image by user specified angle and options. A 

new document is created in this case.  

e. Flip Horizontal: Flip the image horizontally. A new document is 

created in this case.  

f. Flip Vertical: Flip the image vertically. A new document is created 

in this case.  

g. Skew Horizontal: Skew the image horizontally by desired degree. 

A new document is created in this case.  

h. Skew Vertical: Skew the image vertically by desired degree. A new 

document is created in this case.  

i. Add White highlight channel. Refer page 121. 

j. Add White Underbase Choke Mask. Refer page 122. 

k. Add Transparency channel. Refer page 124. 
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Adjustment Menu Commands 

See „Making Color Adjustments‟ on page 105. 

 

Selection Menu Commands 

Selection Menu 

 
a. Create/ Delete selection: To Create/ Delete the selection.  

b. Show / Hide selection: To Show / Hide the selection.   

c. Crop: Crop the selected portion as a new document.  

d. Transform Selection: Resize the selection. 

 

Color Menu Commands 

See „Color Management Options‟ on page 27. 
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Queue Manager Menu Commands 

Queue Manager Menu 

 

 Show/Hide Queue Manager: To Show/ Hide the Queue 

Manager interface.  

 Add The Active Document: To add the active document to the 

print queue.  

 Add All Opened Documents: To add all the opened documents to 

the print queue.  

 Load Job...:  To load a job from the disk.  

 Port Manager...:  To access the port manager. 

 
Note See also Chapter on „Printing‟ on page 31. 

 

Options Menu Commands 

 

Options Menu 

 

j 
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a. Print preferences: These are the settings that are assigned by 

default to a job whose print settings are not set even once. See also 

„Using Print Preferences‟ on page 159. 

b. General Preferences: Settings for cache and scratch space. See 

also „Using Memory and Scratch Space Settings‟ on page 158. 

c. Queue Manager Preferences: See „Print Queue Manager 

Preferences‟ on page 39. 

d. Custom Printer Preferences: See „Custom Print Preference‟ on 

page 160.  

e. Ink Cost: Refer page 161 for more details. 

 

View Menu Commands 

View Menu 

 
a. Toolbar: Shows or hides the toolbar.  
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b. Custom Print Toolbar: Shows or hides the Printer settings toolbar.  

c. Layout Toolbar: Shows or hides the Layout toolbar.  

d. Layout Setting Toolbar: Shows or hides the layout settings 

toolbar. 

e. Status Bar: Shows or hides the status bar.  

f. Channel Palette: See figure below. 

Channel Palette in View Menu 

 

 Show/Hide the channel palette. 

 Show/Hide the channel thumbnail view. 

 

g. Show/hide Tool Palette: See „tool palette‟ on page 142. 

h. Show/hide Notepad: See „Notepad‟ on page 155. 

i. Show/hide Info palette: See „Info palette‟ on page 144. 

j. Show/hide Q Rip: See „Q Rip‟ on page 157. 

k. Show/hide File browser: See „file browser‟ on page 156. 

l. Zoom to Fit: Zoom the active design to fit the window size that is 

containing it. 

m. Zoom In: Zoom in the active design. 

n. Zoom Out: Zoom out the active design. 

o. Image Info: Image related information. See also „Image Info‟ on 

page 149. 

p. Show Rulers: Show or hide the rulers for the current document. 

q. Guides: See figure below. 

Guides in View Menu 

 

 When you want to lock all the guides, use command (1).  
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 When you tick on option (2), your guidelines in the document 

will remain visible in blue color. If you don‟t tick on this option, 

guideline properties will remain but guidelines will not be 

visible.  

 Option (3) is useful when you want to clear/ remove all the 

guidelines from the document. To clear individual guideline, 

drag and drop the guideline over the ruler. 

  

r. Reset Toolbars: Resets the position, visibility state and floating 

state of all toolbars. 

 

Language Menu Commands 

The Language menu offers the following commands, which enables you 
to run the application in different languages as per your choice: 

 

Language Menu 

 
As shown in the above dialog, the 'Language menu' may offer several 
languages from which you can select any one in which you would prefer to 
run the Print Pro application. 

 

Note  

The "Language Menu" command will be available only when 

your version of software supports multiple languages.  

Options in this menu may differ according to the languages 

supported by your version of software. 
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Window Menu Commands 

Windows Menu 

 
The Window menu offers the following commands, which enable you to 
arrange multiple views of multiple documents in the application window:  

 

 Close: Close the current file in use.  

 Close All: Close all the opened files.  

 Cascade: Arranges windows in an overlapped fashion.  

 Tile: Arranges windows in non-overlapped tiles.  

 Arrange Icons: Arranges icons of minimized windows.  

 Window 1, 2...: Goes to specified window. 
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Help Menu Commands 

 

Help Menu 

 
The Help menu offers the following commands, which provide you assistance 
with this application: 
 

 Help Topics: Offers you an index to topics on which you can get 

help. 

 About Print Pro...: Displays the copyright notice and version 

number of this application.  
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Toolbar 

Toolbar provides shortcuts to the most commonly used menu commands.  
 

Application Window Toolbar 

 
a. Open a design document. 

b. Print the active design document. 

c. Printer settings. 

d. Print options for the active design document. See also chapter on 

„Printing‟ on page 31. 

e. Preview the active design document, with page layout etc. See also 

chapter on „Printing‟ on page 31. 

f. Image related information. See also „Image Info‟ on page 149. 

g. Settings for cache and scratch space. See also „Using Memory and 

Scratch Space Settings‟ on page 158. 

h. Color management settings. See also chapter on „Color 

Management‟ on page 20. 

i. Spot color gain. See also chapter on „Color Management‟ on page 

22. 

j. Click here to set the color in which you want to view the white 

highlight channel data. 

k. Open or close the Layout session interface. 

l. About Print Pro. 

m. Context sensitive help. 

n. Exit Print Pro. 
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Printer Settings Toolbar 

Custom Print Toolbar 

 
a. Strength: This is a strength option which is used to control the 

amount of application of each individual option. 0% means no 

strength and 100% means full strength. In past whatever you may 

have created and used with the software was at full strength i.e. 

100%. Now you could control the application of the amount of the 

feature. For example if you use the Choke Strength to be 50% then 

the choking will be applied by 50% amount of the gray value in the 

corresponding channel. Similarly, if you use the Underbase Strength 

to be 50%, the underbase that will be printed will be half the 

strength that otherwise would be printed when this value is 100%. 

b. Highlight Generator: There are four options-  

1. None: If you don't want to apply 'Highlight Generator' 

feature, then select this option. 

2. Channel Based: Highlight option will work as usual using 

the channels. Fuzziness value is disabled and ignored. 

3. On the fly: The RIP will generate the white highlight on 

the fly during ripping using the fuzziness value that you 

supply there. This will ignore any highlight channel set 

otherwise in the channel palette. The fuzziness value works 

similar to the highlight channel creation option. 

4. Combine: The RIP will generate the white highlight on the 

fly during ripping using the fuzziness value that you supply 

there and will combine it with the highlight channels set in 

the channel palette. The fuzziness value works similar to 

the highlight channel creation option. 
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c. Highlight Fuzziness: The fuzziness value works similar to the 

highlight channel creation options. This will be disabled in the case 

of Channel based Highlight generator. 

d. Horizontal Position specifies the offset with which the page will be 

printed. 

e. Vertical Position specifies the offset with which the page will be 

printed. 

f. Color booster: Adjust the percentage to increase the amount of 

color depth. 

g. Environment: Environment name shows the currently loaded 

environment settings. As described earlier you can save the snap 

shot of a print setup as print environment file. Default settings of a 

printer are always loaded as “Custom”. 

h. Manage env: Manage env button enables a user to load to 

associate a generic name with an environment file. The user can 

then select the name associated from the name list to load the 

environment settings saved in the environment file associated with 

the selected name. Pressing the button displays “Manage 

Environment” dialog box. Refer page 47 for more details. 

i. Manage env Group: Manage env Group button enables a user to 

manage the environment file into group. Pressing the button 

displays the „Manage Environment Group‟ dialog box. Refer page 50 

for more details. 

 

Tool Palette 

Tool Palette 

 
a. Eye Dropper Tool: The eyedropper tool samples color to designate 

a new foreground or background color.  

b. Selection tool: Use this tool to create a selection (Use <Shift> + 

<Click> to open „Creating Selection‟ box).  

c. Pan tool: Use this tool to navigate through the design.  
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d. Zoom tool: Zoom in or out the design. Press <Alt> key along with 

the mouse click to zoom out. 

 

Channel Palette 

Channel Palette 

 
a. Channel Information.  

b. Channel Visibility.  

c. Channel Thumbnail.  

d. Cannel Name.  

e. Channel Type*.  

f. Channel Color. 

 
* Legends: A- Alpha, + - Additive (e.g. RGB), - - Subtractive (e.g. CMYK), E 
– Encoded (e.g. LAB), T - Transparent, W - White Highlight, C - White 
Underbase Choke, M – White Underbase choke mask, S - Spot. 
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White Highlight on Spot / Alpha Channels:  
 
To use a spot/alpha channel as a white highlight data, right click on the 
channel and in the menu that appears set the option to use the channel for 
white highlight. 
 

Info Palette 

Info palette lets you know the color value of the pixel below the mouse 
pointer when the mouse hovers over the image. The info palette also shows 
a visual color sample of that pixel color and much more. Info palette lets you 

compare the color value of a pixel in two different color spaces 
simultaneously. 
 
Info palette is capable of providing all of the following information: 

 
 The numeric value (Grayscale, RGB, HSB, CMYK, Lab and LCH) of the 

color beneath the mouse pointer in two different color spaces 

simultaneously.  

 The opacity value for the pixel below the pointer.  

 The x and y-co-ordinates (in inch/cm/mm/points/pixels) of the pointer. 

 The width, height and the anchor point, when a region of the image is 

selected using the selection tool. You can view this information in all 

basic units (inch, cm, mm, points and pixels). 

 

When you use any color adjustment dialog box (for example, Curves), the 
Info palette displays the before and after color values of the pixels beneath 
the pointer. 
 
You can view the info palette by choosing the command View > Show Info 
from the menu. 
 
You can use the info palette to see the color value of pixels of the image 
under the pointer. It also shows the width and height of the selected portion 
in units that are being used in the rulers. 
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Info Palette 

 
The info palette is shown below along with the details of the information 
available from the info palette. 

 
a. Tracks actual color value.  

b. Tracks user chosen color value.  

c. Shows a visual sample of the pixel color.  

d. Tracks cursor co-ordinates below mouse pointer.  

e. Tracks selection width and height.  

f. Shows anchor position of the selected area. 

 
By default the top-left cell shows the color value in the color mode of the 

image and the top-right cell displays in Lab. 
 

Info palette after applying color adjustments filters: 

The info palette lets you know the current pixel color as well as the pixel 
color before applying filters ( if applied ) simultaneously. A sample palette 

window after making color adjustments is shown below. 
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Info Palette after Applying the Filters 

 
The color sample patch is divided into two parts. The left part of the sample 
box shows the original color and the right part shows the color after the 
adjustment. The numeric values also denote the color value in 
“original/current” format. 
 

Using different options in info palette: 

a. You could change the color space in which the numeric values of 

the color are displayed at any point of time using the menu 

provided with these cells. The menu will be presented to you when 

you press the   button in the cells denoting the color values.  

 

The following figure shows this menu. 
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Info Palette with Menu 

 
The menu has the items listed below: 

 

i. Actual color: This selection will show the color value in the 

current color mode of the image. 

ii. Different color spaces: You are also given the option to view 

the color value in grayscale, RGB, HSB, CMYK, Lab and LCH 

mode. 

iii. Opacity: You can select this option if you want to view the 

opacity of the pixel below the pointer. 

 

b. You will see a tick mark besides the option using which the color value is 

being viewed currently. You can change the units in which you are 

viewing the mouse co-ordinates, the width and height of selection and 

the anchor point of the selection. You need to click on the button 

provided in their respective cells to change the units. You are provided 

the options to view them in inches, cm, mm, points and pixels. You can 

click on the buttons ,  and  in the window to view the units 

menu. Changing the units using any of these buttons will change the 

units in all the cells. The menu is shown in the following page. 
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Info Palette with Unit Menu 
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Other Features 

Let‟s take a closer look at the other features that provide useful support to 
rest of the application components. 
 

Image Info 

Image Information Box 

 

The information about the design selected for printing can be obtained 
collectively from the Image information box which can be accessed from 
View > Image Info. This information includes file name along with the path, 
file type, dimensions of the design, design resolution and design mode. 

 

Note Right mouse click allows the dimension unit to be changed. 
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Creating Selection 

Selection Tool 

 
a. Style: You can select either the normal style in which the selection 

box is of any size and the other style is „Fixed‟ style in which the 

selection rectangle is of fixed size. Another one is „Fixed Aspect 

Ratio‟ style in which you have to specify the aspect ration in X and Y 

direction and selection rectangle will increase as per that aspect 

ratio.  

b. Height and Width of the selection rectangle when the fixed style is 

selected and Aspect ratio in case of „Fixed aspect ratio‟ style. 

c. Unit: It specifies the unit of measurement. 

 

Note 

You can open this selection box either by <Shift> + <Click> 

on Selection tool in the tool palette or by going as Selection > 

<Shift> + New Selection i.e. <Shift> + <Click> inside the 

selection while transform selection is being applied. 
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Color Picker 

You can use the Color Picker to select the foreground or background color by 
choosing from a color spectrum or by defining colors numerically. 

 

Color Picker 

 

a. Slider for the unselected values.  

b. Currently selected color.  

c. Previously selected color.  

d. Numerically select the color based on the HSV, RGB, Lab and 

CMYK color model.  

e. Slider for the selected values (Radio Selected value). 
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Rotate 

Rotation of the image by a user specified angle and background color. A new 
document is created in this case. 

 

Rotate Parameters 

 
You can rotate the image either clockwise (select CW) or Counter clockwise 
(select CCW). 
 
You can skew the image either horizontally or vertically by desired degree. A 
new document is created in this case also. 

 

Note You can access Rotate feature by going as Image > Rotate... 
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File Saving Options 

 

Bmp Options 

 

BMP Save Option Box 

 
While saving the file in the BMP format, you can select whether the file 
should be compressed or not. 
 

Tiff Options 

Tiff Save Option Box 

 
Many file formats use compression to reduce the file size of images. You can 
select any of the given compression scheme while saving the file in “.tiff” 
format.  
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Jpeg Options 

Jpeg Save Option Box 

 

a. Image Quality: To specify the image quality, choose an option 

from this menu.  

b. Format options: You can select any of the following format 

options: 

1. Select Baseline (“Standard”) to use a format recognized by 

most Web browsers. 

2. Select Baseline Optimized for optimized color and a slightly 

smaller file size. 

3. Progressive to display a series of increasingly detailed scans 

(you specify how many) as the image downloads. 
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Notepad 

 

Notepad 

 
Notepad can be used to write comments related to a design, and these 
comments are automatically saved in the PST file on close of the image next 
time these comments will be automatically loaded. 
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File Browser 

File Browser 

 
a. List of the files in a folder that can either be opened inside Print Pro 

or can be imported directly into the page layout by drag and drop. 

Files shown in the bold letters indicate that a corresponding .PST 

files exists. In this figure equivalent .PST for 106.jpg, 108.jpg and 

11.jpg. 
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Quick RIP 

Quick RIP 

 
a. Q Rip Settings: Commonly used settings for a print job including 

its size, position in page layout, mirroring the image about the 

vertical axis and inverting the colors of the image in the print. See 

also „Print Settings‟ on page 69.  

b. Print Setup: Access to printer setup.  

c. Print: Print the active document / job. 
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Using Memory and Scratch Space Settings 

Memory and Scratch Space Adjustment Box 

 
a. Physical RAM usage: Physical RAM usage box provide the detail 

information about available system RAM, RAM used by the Print Pro 

and instructed RAM amount for use by Print Pro.  

b. Primary disk used: Select a Primary Scratch Space from the list of 

available spaces.  

c. Remove secondary disks from the used list.  

d. Add secondary disk spaces from the available list.  
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e. Cache Settings: Cache levels and flag to indicate whether to use 

the cache levels when computing the histogram for the images. 

 

Using Print Preferences 

Print Preferences 

 
a. Print Buffer Size: The amount of design data transferred to the 

printer in single shift (W x H = Size x Size). 

b. Standard Prepress values: These values are to be used when loading 

the file and no previous settings are present. For more details 'Print 

Options'. 

 

These default settings are used for the designs that are opened for the first 
time or the one‟s having no equivalent .PST files. See also „About PST files‟ 
on page 164. 
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Using Custom Print Preferences 

Custom Print Preferences 

 
a. Specify the segment size checkbox: Check this button to specify 

the segment size. This option is not available in Microsoft® 

Windows® 98 & Microsoft® Windows® ME systems.  

b. Segment size (in MB): Maximum size for the each segment which 

you want to allow. In the Windows® 98 & ME systems, the 

maximum size allowed for file is 2GB. If you are saving the kprn file 

which is more than 2GB & if your operating system is Windows® 98 

& ME, then that kprn file will not be saved. To overcome this 

problem we are allowing you to specify the maximum size of each 

segment so that your kprn file will be saved & gets loaded properly. 

By default we are keeping the segment size as 2GB for Windows® 

98 & ME systems. 
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Ink Cost 

Ink Cost Dialog 

 
a. Ink cost per liter for the individual ink. If any ink present other than 

the CMYK and White then set cost into the „Other‟. 

 

Use the above dialog to specify the ink cost per liter of ink. This cost is 
used to compute the cost of the print. The currency for the cost is taken 
from the regional settings. Regional settings for modifying the currency can 
be accessed from Control Panel. The path to change the currency depends 
upon the operating system. 
 

 For Windows XP/Vista:  Control Panel > Regional & Language 

Options > press the 'Customize this format' button, Go to 'currency' 

tab and change the currency symbol as desired. 

 For Windows 95, 98, ME and 2000: Control Panel > Regional 

Options > Go to 'currency' tab and change the currency symbol as 

desired. 

 

Cost of the print is available for viewing in the "Print Queue" as shown in the 
figure below. You can view these details after the job is saved, ripped or 
printed. There are two details that are displayed. 
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1. Individual ink consumption (Optional feature). 

2. Total cost of the print (Optional feature). 

 

This cost analysis is for single copy irrespective of the total number of copies 
entered in queue manager. However this does include the number of passes 
of underbase layer, color layer, and white highlight layer if any. 

 

Ink Coverage & Cost of the Print in the 'Print Queue' 

 

Note 

This dialog ("Ink Cost") is marked as the Optional feature; so it 

may or may not be present in the basic version of the 

software. 
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Supported Image File Formats 

Print Pro supports only raster file formats. The formats recognized by Print 
Pro are as follows. 

 
1. BMP:  It doesn‟t support files with Jpeg and ICC extensions.  

2. GIF: Version 89a.  

3. JPG: Version 1.02. It does not support YcbCr, YCCk color spaces.  

4. PCX: Version 3.0.  

5. PNG: It does not support 2 bit per pixel PNG.  

6. TGA: Version 2.0.  

7. TIF:  It doesn‟t support files with Jpeg and Zip compression.  

8. PSD. 

 

Other File Formats 

1. *.kcm : Kothari Color Management files  

2. *.env : Kothari Environment files  

3. *.kpa : Kothari Primary Adjustment files  

4. *.pst : Printer settings files  

5. *.trc : Tone Reproduction Curve files  

6. *.lin : Linearization files  

7. *.fcm : Channel Mixer files  

8. *.fsc : Selective Color files  

9. *.fhs : Hue Saturation files  

10. *.flv : Level files  

11. *.fcv : Curve files  

12. *.fcb : Color Balance files  

13. *.icc, *.icw : ICC Color Profiles  

14. *.prn, *.kprn : File format to save ripped data  

15. *.klt : Kothari Layout Template 
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About PST Files 

PST is Print Pro‟s file format for storing the print options that you may 
specify for the document in Print Pro. Since none of the image file formats 
mentioned above supports the features offered by Print Pro, therefore Print 
Pro makes a file with the same path, name and .PST extension when you 
close the design. Next time when you open the same design Print Pro will 
read these options automatically, so as you don‟t have to remember and re-
enter those options. 
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Productivity Features 

Print Pro‟s user interface has been designed to boost your productivity. 
 

General Patterns 

Commonly needed tasks are either accessible through right button click „List 
of commands‟ or keyboard shortcuts. 
 

Shortcuts 

The „Application Window‟ provides the following keyboard shortcuts, 
 

 Open : <Ctrl> + <O>  

 Print : <Ctrl> + <P>  

 Print Preview : <F9>  

 Print Options : <Ctrl> + <T>  

 Print Setup : <Ctrl> + <Shift> + <P>  

 General Preferences : <Ctrl> + <K>  

 Color Management : <Ctrl> + <Shift> + <K>  

 Spot Color Gain : <Ctrl> + <G>  

 Image Info : <Ctrl> + <Shift> + <I>  

 Zoom In : <Ctrl> + <+>  

 Zoom Out : <Ctrl> + <->  

 Help : <F1>  

 Context Sensitive Help : <Shift> + <F1>  

 Next Pane : <Ctrl> + <F6>  

 Previous Pane : <Shift> + <Ctrl> + <F6> 
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The „Adjustment Interface‟ provides the following keyboard shortcuts, 

  

 Levels : <Ctrl>+<E>  

 Auto Levels : <Shift>+<Ctrl>+<E>  

 Auto Contrast : <Alt>+<Shift>+<Ctrl>+<E>  

 Curves : <Ctrl>+<Shift>+<M>  

 Color Balance : <Ctrl>+<B>  

 Hue / Saturation : <Ctrl>+<U>  

 Desaturate : <Shift>+<Ctrl>+<U> 

 
The „Print Preview Interface‟ provides the following keyboard shortcuts, 
 

 Print : <Ctrl> + <P >  

 Print Setup : <Ctrl> + <Shift> + <P>  

 Print Options : <Ctrl> + <T>  

 View Next Page : <Ctrl> + <PgDn>  

 View Previous Page : <Ctrl> + <PgUp>  

 View One Page : <Ctrl> + <1>  

 View Two Pages : <Ctrl> + <2>  

 Zoom In : <Ctrl> + <+>  

 Zoom Out : <Ctrl> + <->    

 Close Print Preview : <Esc> 

 

The "Edit Menu" provides the following keyboard shortcuts, 

 

 Undo : <Ctrl> + <Z>  

 Step Forward : <Shift> + <Ctrl> + <Z>  

 Step Backward : <Alt> +  <Ctrl> + <Z> 

 



 

167 

Right click ‘List of Commands’ 

 

For Application Window 

 

Right Click Options Available in Application Window 

 

For Print Preview 

 

Right Click Options Available in Print Preview Interface 
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Others 

1. Whenever you need to change units, right click option to change the 

units is available. 

2. In every value edit box along with a spin control, values can be 

incremented or decremented by using <Up> and <Down> keys 

respectively. 
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Common messages and 
trouble-shooting  

Messages 

 

Printing Related 

"Print settings have changed. Save new settings?" 

 

Print Pro will ask you this question before closing a document, if it finds print 

options for this document has changed. Upon confirmation it saves the 

modified print options in a file on the disk with name same as that of the 

document but with the extension PST. 

 

"There is nothing to print. Please make a selection for printing." 

 

If there is no job selected for printing Print Pro will issue this message. It is 

possible that you may have forgotten to select the job that you want to print. 

 

“There are no channels visible in the document. So the document will be 

blank.” 

 

Make at-least one channel visible by selecting it on the channel palette. This 

message generally appears when no channel is visible and user is trying to 

print a composite/color image. 

 

"Failed to acquire printer. Check the printer availability." 

 

Print Pro issues this message when it fails to get handle to the printer driver. 

There may be no printer driver installed on the system. If so, install the 

driver for the printer you want to work with. If driver is already installed, 

then restart the system. 
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"Not a valid media Info" 

 

TRC and ICC profiles as specified in the media definition are missing.  

 

"Ink Type not present" 

 

Ink type for the given media type is not present. Remedy is to reinstall the 

software. 

 

"Media Type not present" 

 

Current selected media type definition cannot be found. Remedy is to 

reinstall the software. 

 

"Loaded Env file <name> is empty" 

"Environment file <name> is damaged" 

 

Currently loaded environment file is empty/ damaged. Load correct/different 

environment file. 

 

"Loaded Kprn file <name> is empty" 

"Kprn file <name> is damaged" 

 

„.Kprn‟ file contains the ripped data. Currently loaded ripped file is empty/ 

damaged. Load correct/different ripped file. 

 

"Error in RTL Writer" 

"Custom writer has performed an illegal operation" 

"CustomPrint has performed an illegal operation" 

 

Error occurred while converting the data to the printer format. We 

recommend you to save all the data and restart your computer. 

 

"Error in writing printer data" 

 

There was some error while writing the ripped data to the temporary file. We 

recommend you to increase the free disk space and restart the job. 

 

"Error in transforming image data" 
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There was some error while converting the given image data into the desired 

mode. We recommend you to save all the data and restart your computer. 

 

“The margins overlap or they are off the paper. Enter a different margin 

size.” 

 

Margins of the paper are overlapping i.e. very less effective page size is 

remaining for printing. So either increase the page size or decrease the 

margin. 

 

“White base is present in more slots than allowed.” 

 

The number of ink slots assigned to the white under base ink is more than 

the maximum permissible slots for the white under base. The maximum 

value is the difference between the total ink slots in the printer and  

 

“Selected port is not a valid port name.”  

“Default printer is not found”  

“Error in starting the print job.”  

“Cannot read from the Spot Gain file. Using default value instead. Choose 

the appropriate setup using the Spot gain setup box.” 

 

When the spot gain file is corrupted for some reason the default gain file is 

utilized. This message conveys the same.  

 

“Too small page size to hold a single calibration bar.” 

 

When the calibration bar cannot be printed within a single selected page size. 

 

“Error in generating patches.” 

 

When some error occurs while creating test patches for printing.  

 

“The margins overlap or they are off the paper. Enter a different margin 

size.” 

 

The margins are not valid for the selected paper size. 

 

“Error while generating printing data” 

Some error occurred while generating printing data.  
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“Error while resampling image data.” 

 

Error occurred while applying the sampling method to the data.  

 

“<name> is not a valid port name.” 

 

Port selected for printing is invalid. 

 

Color Management Related 

"Error in color profile" 

"Doesn't recognize this printer profile" 

 

Currently selected ICC profile for printing the image data is not valid. Select 

a valid ICC profile. 

 

"Error in initializing the TRC Curves" 

"Error in reading the TRC Curves" 

 

There was some error in reading the TRC Cures. We recommend you to 

check the TRC Curves file. If problem persist then restart your computer. 

 

"Didn‟t got the Working RGB profile" 

 

We recommend you to select a valid RGB profile from color management 

dialog box.  

 

KDEF Related 

"Media is Already Present" 

 

Informs that an exact media is already present for the printer selected, when 

a new one of same name and settings is added. 

 

"Not a valid media Info" 

 

The settings for the media were invalid.  

"Ink Type not Present" 
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The ink type requested is not present. 

 

"Media Type not Present" 

 

The media type requested not present. 

 

"Last media entry cannot be deleted." 

 

The media that the user is trying to delete is the last user, hence cannot be 

deleted. There has to be at least one media present.  

 

"Damaged KDF File" 

"KDF file for printer <printer name> is damaged" 

"KDF file for printer <printer name> is empty" 

"File <filename> is not a valid KDF File." 

 

Printer definition file for the Print Pro‟s custom driver is damaged. Remedy is 

to reinstall the software. 

 

"Not a valid paper Info" 

 

Information provided for paper is invalid.  

 

"Last paper entry cannot be deleted" 

 

The paper info that the user is trying to delete is the last user, hence cannot 

be deleted. There has to be at least one user-defined paper info present. 

 

"Paper Size not present" 

 

Requested paper size is not available. 

 

“Unable to Add/Remove paper size as other properties dependant on it.” 

 

It is not possible to modify paper info since there are other dependents on it. 

 

"Kdef file reader has performed an illegal operation" 

 

There was some error while interpreting the data for custom printer driver. 

We recommend you to save all the data and restart the application. If the 

problem persists then restart the computer. 
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Standard Error Messages 

"Low on memory" 

 

The system is low on memory. 

 

"Error in Tiff Seperation Writer" 

 

Error in tiff writer. 

 

"Error while halftoning the image data" 

 

Error occurred while halftoning the data. 

 

"Error in color profile" 

 

Error occurred because of some problem in color profile.  

 

"Error in writing printer data" 

"Error in transforming image data" 

 

Error occurred while applying transformation to the image data. 

 

"Error in initializing the TRC Curves" 

 

TRC curves could not be initialized. 

 

"Error in reading the TRC Curves" 

"Didn‟t get the SRGB profile" 

 

The sRGB profile is unavailable. 

 

"Didn‟t got the Working RGB profile" 

 

The working RGB profile is unavailable. 

 

"No printer selected" 

"No printer to remove" 

"No printer is selected to be added" 

"Default printer is not present in the selected printer list."  
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"Damaged CustomPrint.ini file" 

 

The .ini file for Print Pro is damaged. 

 

Resources Related 

"System is low resources. We recommend you to shut down and start again." 

"Low on memory" 

“Not enough memory to complete the operation” 

 

This message is issued typically when the RAM available to Print Pro is very 

less, or Print Pro fails to acquire the required resources to carry out the 

requested operation. It is a general indication of system getting unstable. 

  

“Lower RAM than minimum required for working of the application. 

Upgradation of RAM suggested." 

   

This message is issued at the time of application initialization, if the available 

RAM is less than that instructed to use for Image management. Remedy is to 

add more RAM to the system. Print Pro needs minimum of 4 MB physical 

RAM for its image handling system. 

 

"Low RAM available than requested. Trying with maximum available RAM." 

 

This message is issued at the time of application initialization, if the available 

RAM is less than that instructed to use for Image management. Print Pro 

continues initialization with whatever amount of physical RAM available. 
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File Reading / Writing Related 

"Could not read the file. An error occurred while reading." 

 

The file may be corrupt.  

 

"Could not write the file. An error occurred while writing." 

 

Disk may be full. Free some space on the disk and try again. Or you may be 

trying to write on a read only media. 

 

“Unable to read/write ICC profile.” 

  

The given ICC profile may be either corrupt or may not be compatible with 

Print Pro. 

 

Application Related 

"Application could not be initialized properly .We recommend you to reinstall 

the application." 

 

Initialization file/s may have got corrupted. Reinstall the application. 

 

Page Layout Related 

"Layout is empty nothing will be printed." or "There are no jobs in the layout 

to print." 

 

Print Pro will issue this message when the page layout being printed is 

empty. 

 

"The following layout(s) contain(s) screen or composites from this document. 

If you close this document these screens will be removed from respective 

layout" "DO you still want to CLOSE?" 

 

Print Pro issues this message when you are closing an open document and 

jobs from that document are present inside a page layout. 

 

“Error in rotating the image buffer for printing.” 
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When some error occurs in rotating the image while printing the layout. 

 

“Template file <file name> is invalid.” 

“Error in reading layout template file <file name>.” 

 

Template file you are trying to open is invalid or corrupted. 
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Section 3 

P L A T E N  O R G A N I Z E R
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Platen Organizer 

(Optional Feature) 
 

What is 'Platen Organizer'? 

Platen Organizer allows to place multiple platens in a single page. Through 
use of platen organizer one can avoid wastage of printing material as well as 
time by efficient placement of platens. Platen is used to hold the print job 
within the platen bounding rectangle. 
 
Platen Organizer allows you to create layout template using various page 
size and printer combinations as you want and that designed template is 

used into Print Pro to print the composed design. 
 
To launch the Platen Organizer application click on the 'Open Platen 
Organizer' button in 'Layout Setting' toolbar of Print Pro as shown in below 
figure. 

 

Launch Platen Organizer button in Print Pro 

 
Another ways to launch the platen organizer is Start > Programs > Print Pro 
DTG Viper > Platen Organizer. 
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More details on what you can do with ‘Platen 
Organizer’ 

1. Arrange platens in a single page with different page size and printer 

combinations.  

2. Layout the platens on the page with more accuracy and ease with the 

help of rulers and guidelines.  

3. Automatic spacing between different platens on the page at equal or any 

other distance as desired.  

4. Layout and nest multiples copies of the original platen in fraction of a 

second.  

5. With Multiple selections of the platens in the platen organizer, replicating 

each job is easy.  

6. Arrange the bunch of designs in exact center of the page and also align 

other platens as per the focused platen placement.  

7. It allows you to specify printer settings for white, black, color and dark 

color background garments.  

8. Manage list of platens with various size as per requirement.  

9. Saving/Loading of layout template. 

10. Manage list of saved layout template files for quick open. 
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Application Window 

Application Window 
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a. Menu bar. 

b. Layout template setting tool bar. 

c. Layout platen adjustment tool bar. 

d. Job properties view shows properties of the currently selected 

platen.  

e. Custom print quick settings tool bar. 

f. Job list view contains list of available platens to add into the 

layout. 

g. Layout view is the preview of the current layout. It is the main 

working area of the platen organizer. 

 

Menu Bar 

List of commands offered by Application „Menu bar‟. 
 

File Menu 

The File menu offers the following commands: 

File Menu 

 
a. New Layout Template: Create a new layout template. 

b. Open Layout Template: Open a saved layout template file. 

c. Save Layout Template: Save the designed template into file. 

d. Exit: Exit from the application. 
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Layout Menu 

The Layout menu offers the following commands: 

Layout Menu 

 

a. Add Job: Clicking on this menu will add a single copy of the 

selected original platen in current Layout. Refer following figure for 

better understanding. If you want to add the platen two times, you 

have to click on this menu two times. 

Job List 

 
Alternatively, you can press on „Add‟ button on the page layout 

window to add a copy of the selected platen. 

b. Delete Job: To delete the platens in your layout, press <Ctrl> and 

right click on the platen that you want to remove/delete from 

layout. The particular platen will be selected. Then, press „Delete‟ 
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button. The platen will be removed from the layout. You can also 

press the <Del> key. 

c. Ups: Clicking on this menu will display following dialog box. Enter 

the number of copies of original platen wanted and press OK button. 

Automatically all the copies will be placed in the layout page 

immediately. 

Ups Dialog Box 

 

d. Auto Arrange: Selection of this menu will automatically guide the 

software to arrange platen in the layout while optimizing media 

space. Alternatively, you can right click on your layout and select 

the option „Auto Arrange‟ from the menu bar.  

e. Layout White Garment Print Settings: This option is allowed to 

change the print setup for the current background print settings.  

f. Print Setup: Change the print setup as per the selected print 

background type.  

g. Add new platen: Allows adding new platen into the job list view.  

h. Rotate 90 CW: Rotate the selected platens in 90 degree clock wise.  

i. Rotate 90 CCW: Rotate the selected platens in 90 degree counter 

clock wise.  

j. Rotate 180: Rotate the selected platens in 180 degree.  

k. Check Overlaps: This menu will help to ascertain if there is any 

platen overlaps in the current layout. When you will click on this 

menu, it will show message box „Overlap found‟ OR „No overlap 

found‟ for the current page layout. Refer the following figure. If 

there will not be any overlaps in your layout, it will show message – 

"No overlap found". 
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Check Overlaps 

 

This feature is very useful when you place multiple copies of the 

platen in your layout and do not specify any gap in between the 

platens.  

l. Align: Align selected platen left, right, top, bottom as per the 

focused platen. To put selected platen horizontally and vertically 

center in page select Horz. Center and Vert. respectively. 
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View Menu 

The View menu offers the following commands: 

View Menu 

 
a. Layout Platen Adjustment Tool Bar: Shows or hides the layout 

platen adjustment tool bar.  

b. Layout Settings Toolbar: Show or hides the layout settings tool 

bar.  

c. Custom Print Toolbar: Show or hides custom print tool bar.  

d. Layout Options...: These are the various settings like spacing 

between the platens and color of the bounding rectangle for the 

platens etc. that can be specified by the user.  

e. Zoom In: Zoom in the active design. 

f. Zoom Out: Zoom out the active design.  

g. Guides.  

h. Snap: Checking this option results in snapping of the objects while 

dragging/moving.  

i. Snap To.  

j. Reset Tool bars. 
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Language Menu 

The Language menu in the 'Platen Organiser' application offers the following 
commands, which enables you to run the application in different languages 
as per your choice: 

Language Menu 

 
As shown in the above dialog, the 'Language menu' may offer several 
languages from which you can select any one in which you would prefer to 
run the Print Pro Platen Organiser application. 

 

Note  

The "Language Menu" command in Platen Organiser will be 

available only when your version of software supports multiple 

languages.  Options in this menu may differ according to the 

languages supported by your version of software. 

 

Help Menu 

The Help menu offers the following commands: 

Help Menu 

 
The Help menu offers the following commands, which provide you assistance 
with this application: 
  

 Help Topics: Offers you an index to topics on which you can get help.  

 About Platen Organizer...: Displays the copyright notice and version 

number of this application. 
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Layout Template Setting Toolbar 

Layout Template Setting Toolbar 

 
a. Create new layout template. 

b. Open saved layout template file (*.klt). 

c. Save layout template into template file (*.klt). 

d. Add new platen into job list view. 

e. Change the page printer settings of this layout. Here when you 

click on the arrow button the following options are shown. 

 

 

f. Automatically arranges the present platens in the layout to 

optimize the space used by them in the layout. If required it will 

also rotate the platen in order to optimize the space consumed. This 

also takes into account the default spacing between the platens as 

specified in the “Layout options”. 

g. Zoom in. 

h. Zoom out. 

i. Context Help. 

j. Check to find overlap. 

k. Open layout option dialog. 
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l. Open layout template manager for maintaining the templates. 

m. Opens layout template from managed files. 

n. Currently selected printer name. 

o. Page name and size of layout. 

 

Layout Platen Adjustment Toolbar  

Layout Platen Adjustment Toolbar 

 
a. Add a platen in layout. See „Adding Platens into Layout‟ on page 

213.  

b. Delete selected layout platen(s).  

c. Duplicate the selected platen(s).  

d. Align the selected Platen(s) to the left of the focused Platen.  

e. Align the selected Platen(s) to the right of the focused Platen.  

f. Align the selected Platen(s) to the top of the focused Platen.  

g. Align the selected Platen(s) to the bottom of the focused Platen.  

h. Align the selected Platen(s) to the vertical center of the focused 

Platen.  

i. Align the selected Platen(s) to the horizontal center of the focused 

Platen.  

j. Align the selected Platen(s) to the vertical center of the page.  

k. Align the selected Platen(s) to the horizontal center of the page.  

l. Rotate platen(s) by 90 degrees clockwise.  

m. Rotate platen(s) by 90 degrees counter clockwise.  

n. Rotate platen(s) by 180 degrees. 
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Custom Print Quick Setting Toolbar 

Refer “Printer settings Toolbar” on page 141. 
 

Properties View 

       

Properties View 

 

a. Platen name.  

b. Unit: Unit in which values are shown.  

c. Left (L)-top (T) position of the platen in the layout.  

d. Current cursor (XY) position.  

e. Ruler offsets: The offset of the origin of the ruler with respect to 

the origin of the printable area of the page (margins excluded from 

the physical page size). 

 
Property window shows some important properties of the selected platen in 
the layout.  
 
At the top it shows the platen name.  
 
Then comes the unit in which all other elements are displayed. Here in this 
example the unit used is inch. This unit is always same as that of the layout 
ruler. This can be changed by right clicking on the layout ruler.  
 
Next Left and Top offset of the selected platen is displayed. These offsets are 
from the left of margin and top margin of the page.  
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Cursor position shows the current cursor position with respect to the ruler. 
The left and top offset of the current platen is also in ruler co-ordinate space. 
 

Job List View 

The job list view on the lower left side of the platen organizer shows all the 
available platen. This list gets updated automatically whenever you add a 
new platen. 

Job List View 

 

When ever platen organizer application is started, standard platens managed 
by user is automatically added into job list view. 
 
When template file is opened in platen organizer, platens present into the 
template file are added into the job list view. 
 

Layout View 

The layout view shows preview of the current layout. This shows all the 
platens in the page at their respective positions. The gray rectangle inside 
the page indicates the page margin. Platen can not move beyond this 
rectangle. The margin can be changed by changing printer options. 
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Layout View 

 
To select a platen you can either click on the platen or use <Tab> key. In 
case of overlapped platen you can click by holding <Shift> key to select a 
platen below the selected platen. 
 
To move a platen, drag the platen while holding <Ctrl> key. Or use <Up> or 
<Down> or <Left> or <Right> keys. You can move a copy of the selected 
platen by holding the <Alt> key. 
Platen in the layout can be rotated in steps of 90°. To rotate a platen uses 
right click menu commands. 
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Initially the ruler origins are aligned with page margins (left and top). You 
can change this origin by dragging the cursor from the box marked as ‘A’ in 
the figure above. To reset the origin to the left top of page margin double 
click in ‘A’. 
 
To create guide Drag the cursor from the horizontal or vertical ruler and drop 
in position where you want the guide. You can use <Alt> key to rotate the 
guide 90°. You can also add a guide by using the menu command Layout > 
Guides > Create Guides…. 
 
To move a guide Drag the guide while holding <Ctrl> key. 
 
To delete a guide Move the guide out of the page. To delete all the guides 
use menu command View > Guides > Clear Guides. 
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Right Click Context Menu 

Right Click Context Menu 
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Commands  Short Keys 

 Insert new platen in job list view  Ctrl + S 

 Close Page Layout  Ctrl + L 

 Ups  Shift + Insert 

 Adding up platen in layout  Insert 

 Delete a platen  Del 

 Select a platen in layout 
 Ctrl + Left Click on that particular 
platen        

 Align left  Ctrl + Left Arrow 

 Align right  Ctrl + Right Arrow 

 Align Top  Ctrl + Up Arrow 

 Align Bottom  Ctrl + Down Arrow 

 Select all platen  Ctrl + A 

 Deselect all platen  Ctrl + D 

 Change printer settings  Ctrl + Shift + P 

 Check overlap  Ctrl + C 

 Zoom In  Ctrl + + 

 Zoom Out  Ctrl + -- 

List of Shortcuts 
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Creating New Layout Template 

You can create the new layout template by using the „New Layout Template‟ 
wizard. It will guide you throughout the wizard that how to create new layout 
template with required settings. 
 
To open a layout template wizard click on the 'New Layout Template' button 
in layout setting toolbar or select new layout template option from the File > 
New Layout Template menu. 

 

New Layout Template Wizard 

 

Note  

In the ongoing discussions related to the "Creating New 

Layout Template", we can find mention of the 'Dark Color 

Background Settings' in several places. This feature is marked 

as the 'Optional feature'. So settings related to this option may 

not be present in the basic version of this software. 
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Step 1: Define Printer Settings. 
 
In this step specify that, how do you want to begin? By loading printer 
settings for all background type from existing template file or continue with 
the default print settings. 

 

 
a. Showing the short description about the current step.  

b. Load printer settings from an existing template file: By 

selecting this option you can load printer settings from the existing 

template (.klt) files which are previously saved.  

c. Start with default printer settings: You can continue with the 

default settings which are previously saved default settings by you.  

d. Set Settings as default: This option is used to set the configured 

printer settings as default for the current printer when you finished 

the wizard. This option will become enabled only when the last page 

comes. So next time print settings will be automatically loaded into 

wizard when particular printer is selected.  
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e. Moves to the previous step.  

f. Moves to the next step. 

 

Step 2: Loading Printer Settings from the Existing Template. 
 
This page is visible only when you select the „Load settings from existing 
template‟ in step 1.  

 

 
You can load printer settings of existing template (klt) file for create new 
wizard. 
 

a. List showing the list of template file which are managed using the 

layout template manager. 

b. Click on the open button to load template file from the disk. 
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Step 3:  Specify Printer, Printer Port, Ink Layer Order, Feed Adjust 

between Layers and Platen Ejection Direction. 

 

 
In this step you can specify the printer and port on which printer is 
connected. 
 

a. Printer:  This shows the list of available printers. When ever you 

change the printer, default settings for that printer is loaded. 

b. Printer Port: This shows the list of available printer port. Select 

printer port from the list on which printer is connected. 

c. Ink Layer order: It specifies the ink layer transfer order, means 

whether you want to print first white layer and then color layer or 

color layer and then white layer. 

d. Feed adjust between layers (in mm): Specify the feed adjust 

between layers in mm.  

e. Platen ejection direction: Check this box to eject platen from 

feeding side. 
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Step 4: Specify Media Size and Margins. 
 

 
In this step you can specify the paper and margins. 

 
a. Media size: This field shows the list of media (paper) supported by 

the printer. Here we can specify the page size we want to use. If the 

printer supports custom paper sizes then select one of the “user 

defined” paper sizes from the list whose size can be defined by the 

user by clicking the „User size‟ button.  

b. Source: It determines from where the media is inserted for 

printing.  

c. User size: This button is enabled when the user selects “User 

defined” paper size from the media size list. When you click this 

button a dialog box appears asking for the width and height of the 

new media you want to create.  

d. Add/Remove paper: This button is used to add the new paper 

size or you can remove the paper size which is newly added by you.  
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e. Margins: From this field you can specify the left, right, top and 

bottom margin for the paper. Specify margins such that they does 

not overlap or go off the paper. 

 

Step 5: Specify Printer Ink Slots. 
 

 
Ink assignment page contains the information about the currently loaded 
inkset used for printing. This page will show only the inkset which are 
supported by the printer i.e. if the printer is a 4 channel printer then only 
those inkset will be shown for which the number of inks in the inks set is 
equal to or less than four. 

 

a. Predefined Inksets: List the inkset supported by the currently 

selected printer. 

b. Entries of the selected inkset: These fields are used to specify 

colors for every channel slot as physically present on the printer, i.e. 

specify on which slot which ink is present for the concerned printer. If 

your printer has white inks, specify which slots have white ink. If you 

do not want to print using a channel then set that channel slot number 

as 'None'. 
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Step 6: Specify Media type, Printer Profile and TRC for White 

background. 

 
In this step you can specify the media type, profile and TRC settings for the 
white background garment. 

 

 
a. Media type: It specifies the media on which user wants to print. 

This can be a user created media or a predefined media. Basically 

by selecting a new media user selects a new ICC profile and TRC 

curves for printing which was selected by the user while creating 

that media. Media type can be dependent on ink type or can be 

independent depending on the printer selected. If a media type is 

dependent on ink type then only those media are shown which the 

selected ink type supports. User can still override the ICC profile or 

the TRC curve used by selecting appropriate files using „Load TRC…‟ 

and „Load ICC…‟ buttons.  

b. Ink type: This field shows the list of ink type supported by the 

printer. Many printers have media type dependent on ink type i.e. 
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for one media type you may want to select the different TRC curves 

and ICC profile and for other ink type a different set.  

c. Create media: This button is used to create a new media or 

remove a media created.  

d. Load TRC: Use this option to change the TRC curves used for 

printing an image.  

e. Load printer profile: Use this option to select a different printer 

profile for printing. Remember always load the same number of 

channel printer profile as in the currently loaded inkset.  

f. Load White TRC: Use this option to change the TRC curves used 

for printing the white base for an image. For white background 

white TRC is not required, so this button will remains disabled.  

g. Printer Profile:  Printer profile shows the currently loaded printer 

profile name. 

 
Step 7: Specify Media type, Printer Profile and TRC for Black 

background. 
 
In this step you can specify the media type, profile and TRC settings for the 
black background garment. 
 
In this step all the input remains same as the „Step - 6‟ except „Load White 
TRC…‟ button remains enabled to specify the White TRC for white layer 
labeled as „f‟. 

 
Step 8: Specify Media type, Printer Profile and TRC for Color 
background. 
 
In this step you can specify the media type, profile and TRC settings for the 
color background garment. 
 
In this step all the input remains same as the „Step - 6‟ except „Load White 
TRC…‟ button remains enabled to specify the White TRC for white layer 
labeled as „f‟. 
 

Step 9: Specify Media type, Printer Profile and TRC for Dark color 
background. 
 
In this step you can specify the media type, profile and TRC settings for the 
dark color background garment. 
 
In this step all the input remains same as the „Step - 6‟ except „Load White 
TRC…‟ button remains enabled to specify the White TRC for white layer 
labeled as „f‟. 
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Step 10: Specify Color Correction Settings for White background. 
 

 
a. Printer color adjustment: Check this for color adjustment.  

b. Sliders for color correction.  

c. Use Color booster: Check this to enable color booster.  

d. Color booster value: Adjust the percentage to increase the 

amount of color depth.  

e. Use same settings for all printing backgrounds: Check this 

option to use same color correction settings for the white, black, 

color and dark color garment backgrounds. 

 

Note 

Make changes only if you desire or this will affect the output 

image.  Leave these settings as it is to avoid modify any 

changes in the input image. 
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Step 11: Specify Color Correction Settings for Black background. 
 

All the input remains same as Step–10 for black background type.  
 

If you check the option „Use same settings for all printing backgrounds‟ then 
this step is skipped and color correction settings specified in step-10 is used.  

 
Step 12: Specify Color Correction Settings for Color background. 

 
All the input remains same as Step–10 for color background type.  

 
If you check the option „Use same settings for all printing backgrounds‟ then 
this step is skipped and color correction settings specified in step-10 is used. 

 
Step 13: Specify Color Correction Settings for Dark Color background. 

 
All the input remains same as Step–10 for dark color background type.  

 
If you check the option „Use same settings for all printing backgrounds‟ then 
this step is skipped and color correction settings specified in step-10 is used. 
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Step 14: Specify Print Quality Settings for Color Ink layer. 
 

 

a. Resolution: Select the resolution at which you wish to print. 

b. Color appearance: Select the output color mode. Colored or 

monochrome. 

c. Micro weaving: This option allows the printer to generate superior 

output because graphics data is reordered and is printed in finer 

increments. It reduces the possibility of banding, the light horizontal 

lines that can mar an image. 

d. Print Direction: This option allows you set the printing direction. It 

can be unidirectional or bidirectional. 

e. Dot size: Using this option you can set the size of the dot for 

printing. 

f. Optimize Ripping: Checking the Optimize Ripping will increase the 

ripping speed. 

g. Wet on wet passes: Number of times same row to be printed. 

h. Use Same settings for whitebase & color ink layers: Check this 

button to use current print quality and advanced media settings for 

white base and color ink layers. 
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Step 15: Specify Print Quality Settings for White Ink layer. 
 
This step takes the print quality and resolution settings for white ink layer.  
 
The user interaction will remain same as step-14 except „color appearance‟ 
labeled as „b‟ is remains disabled for white ink layer. 
 
This step is skipped if „Use same setting for whitebase and color ink layers‟ 
labeled as „h‟ is selected. 
 
Step 16: Specify Advanced Media and Dry Time Settings for Color Ink 
layer. 

a. Banding correction: Perform settings for media feed 

compensation. This corrects the errors in the amount of feed of the 

grit rollers due to the type of media used. Correcting the amount of 

feed improves the dot positioning accuracy in the feed direction, 

which can help in enhancing the image quality.  

b. Layers count: Enter the no. of layers of white under base or color 

data to be printed depending on the option selected currently. 
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c. Dry time per scan: Specify the time (in milliseconds) for which the 

head waits before printing each line.  

d. Dry time after print: This setting allows the control of the amount 

of time (in seconds) after which the next layer is printed. 

 

Step 17: Specify Advanced Media and Dry Time Settings for 

Whitebase Ink layer. 

 
This step takes the advanced media and dry time settings for whitebase ink 
layer.  
 
The user interaction will remains same as step-16. 
 
This step is skipped if „Use same setting for whitebase and color ink layers‟ is 
check in step-14. 
 
Step 18: Specify Strength and Highlight Generator Settings for Black 
background. 
 
Strength option is to control the amount of application of each individual 

option. 0% means no strength and 100% means full strength. In past 
whatever you may have created and used with the software was at full 
strength i.e. 100%. Now you could control the application of the amount of 
the feature. 
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a. Choke mask strength: Used to control the strength of the choke 

mask channel. For example if you use the Choke Strength to be 

50% then the choking will be applied by 50% amount of the gray 

value in the corresponding channel. 

b. Underbase strength: Used to control the strength of the 

underbase channel. For example if you use the Underbase Strength 

to be 50%, the underbase that will be printed will be half the 

strength that otherwise would be printed when this value is 100%. 

c. Highlight strength: Used to control the strength of the highlight 

channel. 

d. Highlight Generator: There are four options, 

1. None: When you do not want to apply highlight generator, 

select 'None' from the dropdown list. 

2. Channel Based: Channel Based Highlight option will work 

as usual using the channels. Fuzziness value is disabled 

and ignored. 

3. On the fly: The RIP will generate the white highlight on 

the fly during ripping using the fuzziness value that you 

supply there. This will ignore any highlight channel set 
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otherwise in the channel palette. The fuzziness value works 

similar to the highlight channel creation option. 

4. Combine: The RIP will generate the white highlight on the 

fly during ripping using the fuzziness value that you supply 

there and will combine it with the highlight channels set in 

the channel palette. The fuzziness value works similar to 

the highlight channel creation option. 

 

e. Highlight Fuzziness: The fuzziness value works similar to the 

highlight channel creation options. This will be disabled in the case 

of Channel based Highlight generator. 

f. Set settings as default: Check on this button to set currently 

configured printer settings as default the selected printer. Whenever 

you change the printer during new layout creation dialog these 

settings will be automatically loaded. This option will be enabled in 

the Next (or in the Last step depending on your version of 

software) step. 

 
Step 19: Specify Strength and Highlight Generator Settings for Color 
background. 
 
In this step specify the Strength and Highlight generation settings for Color 
background. 
 
All the controls for input will remain same as „Step-18‟.  
 
Step 20: Specify Strength and Highlight Generator Settings for Dark 
Color background. 
 
In this step specify the Strength and Highlight generation settings for Dark 
Color background. 
 
All the controls for input will remain same as „Step-18‟ except „Set settings 
as default‟ will become enabled in this step, labeled as „f‟. 
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Adding Platens into Layout 

By using menu command Layout > Add new platen, you will get an 'Insert 
Platen' dialog to add new platen. This will add new platen into the job list 
view. 

 

Insert Platen Dialog Box 

 

a. Platen name: Platen name should be unique; otherwise new platen 

is not added into job list view.  

b. Add current platen info into the standard platen list.  

c. Width of platen: This should be up to maximum allowed paper 

width for current printer.  

d. Height of platen: This should be up to maximum allowed paper 

height for current printer.  

e. List of the available standard platens.  

f. Reset standard platen list with factory defaults.  

g. Delete selected platen from standard platen list. 
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You can add new platen into page as follows: 
 

1. By double clicking on the appropriate job from the list on the left 

pane.  

2. Selecting the job and clicking ‘Add’ button on the layout tool bar.  

3. Selecting the job and pressing <Enter>.  

4. By dragging the job from job list view and placing into the layout 

view. 

 

Note 

If the platen cannot be accommodated in the page in erect 

position, it tries to put it through 90° rotation. Rotated platens 

are indicated by vertically displayed platen names. 

 

Note 
Standard platens are automatically added into job list view 

when application starts. 

 

Placing a Platen in Layout View 

Adding a platen places it at the first location on the media where it can fit it 
in an optimized way. Then you can move it to anywhere within the margins 
of the page.   
 
Use zoom-in and zoom-out commands on the layout tool bar to get a proper 
view of the page in use.  
 
To move a platen by using the keyboard, you need to select it first. Then use 
the arrow keys in your keyboard to move the selected platen in appropriate 
direction. For faster displacement, use <Shift> key in combination with these 
keys. 
 
If you want to use the mouse, pressing <Ctrl> key, click the left mouse 
button inside the desired platen rectangle and drag it with mouse button still 
down to the location of your wish.  

 
While dragging a platen if its edge reaches near enough to an edge of 
another platen, the other platen attracts it and tries to place it as closer as 
possible without overlaps. (This is done to save printing material). If you 
want to override this snapping feature then use <Shift> key while dragging 
and place the platen anywhere you like. 

 

Note 
Platen Organizer constraints the placement of the platen within 

the margins of the page. 
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Selecting a Platen in Layout View 

Using Keyboard:  
 
You can navigate through the platens by pressing the <Tab> key. Press 
<Shift> + <Tab> to navigate in the opposite direction.  
 
Using Mouse:  
 
Click inside the rectangle that represents the desired platen. Press <Ctrl> 
key along while clicking to select a platen that is hidden (overlapped) by 
another platen. 
 
Selecting multiple Platens:  
 
Press <Shift> key along with <Ctrl> and mouse click to select multiple 
platens. You can also use <enter> key while moving between the platens 
using the <tab> or <shift>+<tab> key to make multiple selections. 
 
You can also use <ctrl>+<A> to select all the platens in the layout. You can 
use <ctrl>+<D> to deselect the platens. 
 
You can also select multiple platens by drawing a selection rectangle starting 
form the blank space in the layout while holding the <ctrl>key down. All the 
platens having at least 8% of their area in the selection rectangle get 
selected. 
 
You can also toggle the selection status of the platens inside the selection 
rectangle by holding the <shift> key down in the operation as described 
above. 
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Checking for Overlaps 

Platen Organizer offers automatic checking for overlaps between any two 
platens of a layout. To use page optimally, platens should be placed as near 
as possible. But while doing so sometimes a platen may be placed over 
another.  
 
Check „Check overlaps‟ on the layout tool bar to prevent such catastrophe. 
Overlaps would be highlighted in real time (as you move a platen) by 
crossed hatch marks over the overlapped area as shown in the Figure below. 
You can also use Layout > Check Overlaps to check current overlap status 
(this is a one time checking as against real time checking).  

 

Note 
If Overlap is present then you are not able to save the layout 

template. 

 

Check Overlap Button 

 
It can also issue warnings about overlapping of platens visually in real time if 
you want. 
 
When you will check the for the overlap region, it will show message box 
„Overlap found‟ OR „No overlap found‟ for the current page layout. 
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Overlapped Platens 

 

Auto Arrange 

Platens are placed in the layout one after another as you keep adding. But 
they can be arranged in the layout such that their cumulative area is 
minimized.  
 
The auto-arrange command tries to arrange all platens in such a way that 
they occupy minimum printable area.  
 
The space between two successive platens can be set from View > Layout 
Options…. 
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Snapping 

To place platens and guides easily Platen Organizer snaps the moving platen 
or guide to the nearest hot edge.  
 
In case of guide movement this hot edge is the nearest border or halfway 
mark of a platen.  
 
In case of platen movement a hot edge is the nearest edge of another platen 
or a guide.  
 
This snapping facility for the current moving object can be overridden 
holding <shift> while dragging the object (a platen or guide.)  
 
If you don‟t want snapping by default, check off menu command View > 
Snap. Checking this command again will enable snapping.  
 
You can also switch off snapping with platen bounding box and guides 
individually. Use menu command View > Snap To > Guide switch on/off 
snapping with guides. Use menu command View > Snap To > Bounding Box 
switch on/off snapping with platen bounding boxes. 
 

Layout Template 

Layout template is all about saving of the multiple platens in a single page 
with printer settings and placement positions that you made for each base 
type, with or without guidelines. Place the multiple platens in a layout whose 
width and height is defined by you. 
 
Save the layout using “Save layout template”. This can be achieved from the 
following ways: 

Save Layout Template Option 
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a. Right clicking layout will pop up the context menu in which 

Layout template will help you to save the layout or from the main 

layout menu File > Save Layout Template will help you the same.  
b. By using the Save button of Layout setting tool bar. 

 
While saving the layout template following requirements should be fulfilled. 
 
1. No overlap should be present into layout. 

2. Printer settings for each printing base type should set appropriate as 

per the printing background type for color data and white data. 

  
It saves the template file with *.klt (Kothari layout template) extension. It 
saves the printer settings, guidelines and platens with their positions. 

 
Open layout template from file using “Open Layout Template”. This can be 
achieved from the following ways: 

Open Layout Template Option 

 
1. Click on open button in Layout setting tool bar. 

2. From right click context menu select Layout Template > Open 

Layout Template. 
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Layout Template Management 

Layout template management feature allows you to manage list of saved 
layout template file for quick access. 
 
When ever you click on the button layout management button in layout 
setting tool bar, shown as „A‟, it will show the following dialog for maintaining 
the template file list. Managed list of template is shown in pop up menu 
when you click on button shown as 'B'. 

 

Template Management in Layout Setting Toolbar 
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Layout Template Management Dialog 

 
a. List of managed template files: It shows Template name in first 

column and template file path in second column. You can edit the 

information by double clicking on the item. When you double click 

on template file path column it shows edit box with browse button.  

b. Reset layout template management info to the factory defaults.  

c. Delete layout template: To delete the selected layout template 

information.  

d. Add new layout template: To add new layout template 

information. 

 
Right clicking in the list will display the following menu which allows you to 
add or delete entries. 
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Using Layout Options 

Layout Options Box 

 
a. Unit: Unit of displayed job spacing values.  

b. Horizontal: Default horizontal spacing desired between the jobs in 

the layout.  

c. Vertical: Default vertical spacing desired between the jobs in the 

layout. If same spacing button is checked then vertical spacing set 

same as horizontal spacing.  

d. Show bounding box: Check to show bounding box around the 

platen.  

e. Normal: Non-selected platen bounding box color.  

f. Selected: Selected platen bounding box color.  

g. Focused: Focused platen bounding box color.  

h. Show standard platen(s) in job list view:  If this option is 

unchecked then standard platens will not be added into the job list 

view when application starts or new template is created. 
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When the number of platens exceeds the page size in a page layout, further 
platens can only be added after resizing the page. Auto resizing is available 
for only those printers, which supports it. 
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Appendix A 

Glossary 

Calibration 

 

Adjusting the instrument so that it produces accurate and consistent results.  

 

Channel 

  

Equivalent of a printing plate. 

 

CMYK 

 

It is a color space comprising of four inks Cyan, Magenta, Yellow and Black 

based upon subtractive color mixing theory.  

 

Color separation 

  

Process of converting a color image into one or more color plates is called 

color separation. These plates would then used for reproducing the original 

color image on a press.  

 

Densitometer 

   

It is an instrument for measuring the gray density in an area on the film. 

 

Dot gain 

 

The change in the size of a printing dot from the film to the printed sheet, 

usually expressed in terms of percentage. 
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Gamma 

 

A numerical value use to represent the non-linear response curve of an 

output device to light intensity. 

 

Gray scale 

 

Shades between black and white colors.  

 

Interpolation 

 

Interpolation is a process useful in generating the missing information from 

the given data samples. Alternatively in the context of images, interpolation 

is addition of pixels between others, usually done when enlarging the 

bitmap. 

 

Pixel 

 

It is the smallest addressable unit on the printer/monitor. 

 

RGB 

 

It is a color space comprising of three basic primaries Red, Green and Blue 

based upon additive color mixing theory.  

 

Resolution 

 

Resolution is usually defined as the number dots in a linear inch (DPI).  

 

Threshold 

  

This is a level, below which all pixels are considered as black and otherwise 

as white.  

 

TRC compensation 

 

Tone Reproduction Curve compensation. Process of compensating for tonal 

gains/losses during printing. 
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Wedges 

 

Gray scale ramp varying from 100% black to 0% black, changing with 

predefined steps. 

 

White Highlight 

 

A white highlight is generally the area in the image which is either white or is 

close to white. 

 

White Underbase 

 

The white mask that is printed using white ink over the printing base on 

which color data will be printed during subsequent pass. 
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Appendix B 

The length that can be output by Print Pro on your printer using Windows 
Printer Driver is a function of two variables. The resolution at which you want 
to print and the version of Microsoft Windows you are running Print Pro on. 
 
Windows 95, 98 or ME puts the limitation of the maximum number of pixels 
that can be addressed on the printer to 32767. Let us call this as addressable 
length X. If you were printing on a printer with a resolution of Y DPI (dots/ 
pixels per inch), then it would translate to X/Y inches in physical terms. For 
example, if you are printing on a 300 DPI printer the maximum length/width 
that can be printed on a page is 32767 / 300 inches or approx. 109.223 
inches. 
 
Windows NT or 2000 puts the limitation on maximum number of pixels that 
can be addressed to 2147483648 pixels. This would mean that on the same 
300 DPI printer you can print a length of up to 2147483648 / 300 inches or 
7158278.826 inches approx. 
 
Not only the above limitation, but there is another limitation which is 
enforced by the common dialog library of Windows on the reported page 
sizes by them. This size is limited to 129 inches in width and height. On all 
the Windows 95, 98 or ME and Windows NT or 2000 this limitation is 
applicable. 
 
The above discussion is true for both Non-Postscript and Postscript printers 

when printing is done through Windows GDI. Print Pro uses GDI for 
communicating with the printer. Postscript printer tries to solve the issue by 
dividing the reported printer DPI by 2 till the resulting number of pixels 
remain well within the range, but the limitation on the paper size reported 
still remains.  
 
You can still have any size plots from Print Pro by the help of its pagination 
feature, which of course needs to be stitched together. 
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Notes
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